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1.

Introduction

ElixirForm for AFP is an interactive forms design tool
that allows you to create and edit forms in WYSIWYG
(What-You-See-Is-What-You-Get) mode using an IBM
PC, AT, PS/2 or compatible computer and optional
proof printer.
If you are familiar with previous GEM versions of ElixirForm for AFP, you will find that the Windows-based
version includes the same functionality plus additional
features and a new interface. You can easily import
forms created in earlier versions of ElixirForm for AFP
and edit them in the new version.
If you have never used ElixirForm for AFP before, you
will find the product highly intuitive and easy to use.
For brevity, "ElixirForm for AFP" is referred to as "ElixirForm" throughout this guide.

ElixirForm overview
A form created with ElixirForm is the static (or boiler
plate) component of a form, and contains elements
such as lines, boxes, text and images. The static form
is then merged with variable data for printing on AFP
high-speed laser printers.
The static data adds meaning to the variable data with
which it is merged. For example, the following variable
data from a credit application form
X
X

123-456-789
985-234-980

9876.23
11813.34

is more meaningful when merged with static data and
viewed together:
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Previously, creating and editing static forms for printing on AFP printers was the responsibility of applications personnel working on mainframe computers.
Such personnel were required to define form elements using Overlay Generation Language (OGL), a
language that describes the location of line, shape,
text and image elements, as well as page size and
layout.
Limitations to this approach are:
defining and revising an OGL form is complicated
and time-consuming
changes to the form are not apparent when adding OGL statements
the completed OGL file must be compiled and
proof printed on the high-speed printer.
With ElixirForm, you can see each static form element
as you add or revise the element, and then generate
proofs using an optional desktop proof printer. Using
the Elixir Desktop Converter, you can compile your
forms on your PC, thus freeing your AFP printer from
these tasks.
Depending upon the ElixirForm product you have installed, your screens and options may differ from the
figures displayed in this guide.
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Customer support
Elixir customer support centers provide telephone
technical assistance for Elixir users during business
hours.
If you have purchased your Elixir product directly from
Elixir Technologies then contact one of the support
center hotlines.
See the Elixir Forms Editor Getting Started Guide for
information about contacting your support center.

Elixir training
Elixir Technologies Corporation offers training for the
full range of GEM- and Windows-based family of
products. For more information, contact:
Elixir Learning
(805) 641-5900 ext. 6

Who should use this guide
This guide serves users needing first-time or ongoing
reference information about ElixirForm.
Users should already be familiar with Microsoft Windows operations, printer and font management operations and PC peripherals, and have access to
reference manuals for related PC software and
hardware.
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Conventions
This section describes the following:
display conventions
typographical conventions
Display conventions
ElixirForm adheres to Microsoft Windows conventions
for using menus, menu commands, dialog boxes,
command buttons, icons and the mouse. See your
Windows manual for more information.
Many shortcut keys in the new Windows-based product are different from those in previous GEM versions.
This is because the standard Windows oper- ating environment predefines certain functions to keys (for example, <F1> is always used for Help). See the
"Keyboard shortcuts" appendix for a list of keyboard
shortcuts.
Typographical conventions
The following typographical conventions are used
throughout this guide:
Keystrokes are shown enclosed in < > (angle
brackets). For example:
<Enter>.
Key combinations are denoted by a plus sign between keys. For example:
<Shift> + <F1> indicates simultaneously pressing
the <Shift> and <F1> keys.
Menu titles are shown in bold. Menu options are
enclosed in [ ] (square brackets). For example:
Select [New] from the File menu.
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Commands, options, actions and parameters that
require description are shown in bold, followed on
the next line by the description. For example:
Delete
Deletes the selected files.
Steps in a procedure are shown in numbered bold
paragraphs. For example:
1.

At the prompt, enter the file name and
extension.
Comments relating to a step (such as this paragraph) are shown in regular text following the bold
paragraph.
Commands you enter at the DOS prompt display
in larger text. Within DOS commands, variable
names and keys you press are shown in italics.
For example:

CD \ELIXIR <Enter>

On-line Help
Elixir software uses the Microsoft Windows Help program to provide on-line Help for all functions.
For more information about Windows Help, select the
[How to Use Help] option in the Help menu, or see
your Microsoft Windows documentation.
The Help files included with your Elixir software include graphics created using screen drivers with large
fonts. If you use a screen driver with small fonts, the
Help file graphics may not display clearly. For optimum graphics display, use a screen driver with large
fonts.
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You can display on-line Help in the following ways:
Bubble Help
Click on an icon with the right mouse button to view its
properties (if applicable) or to display "bubble help."
Bubble help is a short description of the icon function
that displays in a bubble extending from the icon.
Quick Help
Enable the quick function by selecting the quick help
option in the Usage Switches (or Preferences -- for
ElixirImage) dialog box. When you move the screen
pointer over an icon on the screen, a short description
of the icon function displays in the message area of
the screen. During certain operations a message
about the function you are performing also displays in
the message area. To see these operational messages, disable quick help.
Context sensitive Help
To use this function, click on an icon and press <F1>.
If available, the appropriate Help topic displays. If no
specific topic is available, the Help table of contents
displays.
Help menu
Select [Help] from the top pull-down menu and choose
one of the displayed topics.
Dialog box Help
Click on the [Help] button in a dialog box to view an
associated Help topic. Under Windows 95 and Windows NT, right-click on a dialog box option to display
an associated Help topic.
Help pop-ups and jumps
Within Help topic text, words or phrases underlined in
green are pop-ups or jumps. When you click on a
pop-up topic, a box displays within the current Help
topic with additional information. When you click on a
jump, a different, associated Help topic displays.
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Help hypergraphics
Hypergraphics are special graphics within Help files
that contain "hot spots". Hot spots are either pop-up
topics or jumps. Hypergraphics in Elixir Help are most
commonly dialog boxes with option hot spots (pop-up
definitions), toolboxes with tool hot spots (topic
jumps), and menus with option hot spots (topic jumps
or pop-up definitions).
Move the cursor over a hypergraphic until a hand displays, then click on this hot spot to display a pop-up
topic, or a "jump". To close a pop-up topic, click the
mouse button. To return to the original Help topic
from a jump, click on <Back> in the Help file menu.

Organization of this guide
This guide contains the following chapter and appendices:
Chapter 1, "Introduction", provides an overview of
ElixirForm functions, features, hardware and software
requirements, and documentation.
Chapter 2, "ElixirForm basics", provides an overview
of ElixirForm and describes basic operations for creating a form.
Chapter 3, "ElixirForm defaults", describes how to set
the defaults for a form.
Chapters 4 through 7 "Lines", "Shapes", "Text operations" and "Images" are reference sections explaining
how to create and edit elements using every icon in
the toolbox.
Chapter 8, "Stand-alone utilities", explains the standalone utilities included with ElixirForm.
Appendix A, "Keyboard shortcuts", lists keyboard
shortcuts (fast keys).
"Glossary", contains terms and definitions applicable
to ElixirForm and related Elixir products.
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Starting ElixirForm
To start ElixirForm from the Elixir Desktop, doubleclick on the ElixirForm icon displayed at the right of
the Desktop. The ElixirForm Desktop displays.

Exiting ElixirForm
To exit ElixirForm and return to the Desktop, either
select [Exit] from the File menu or double-click on the
file drawer in the top left corner of the Desktop.

1-8
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ElixirForm basics

This chapter describes the ElixirForm work area and
basic operation. Later chapters describe more advanced ElixirForm operations

Starting ElixirForm
To start ElixirForm, open the Elixir Desktop and
double-click on the ElixirForm icon. The ElixirForm
window displays.

Toolbox

Toolbar

Work area
menu bar

ElixirForm
menu bar

Main work area

Figure 2-1. ElixirForm window
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ElixirForm window
The following section describes the ElixirForm window.
Toolbox <F10>
The Toolbox displays on the left of the main Work
area and contains tools for creating and editing the
elements comprising a form. If you cannot see the
Toolbox, either pull down the Window menu and select [Toolbox] or press <F10>.
Tools

Message
panel
Tool options

Preview
panel

Figure 2-2. Toolbox
The Select/Edit, Line, Path, Box, Circle, Text and Image tools display at the top of the Toolbox.
When you click on a tool, the options for that tool display in the Toolbox. A short description of the tool also
displays in the message panel.
You select tool options by opening associated icons.
The preview panel displays your selection. When you
select a box with a fill, the preview panel also displays
the name of the fill.
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If you want to hide the Toolbox while you work, select
the Show/Hide Toolbox icon in the Toolbar.
Toolbar
The Toolbar displays across the top of the Work area
and includes the digital ruler, selected element and
element coordinates, and object dimensions. Other
Toolbar options allow you to set up user preferences,
perform undo and redo operations, spell check text
and show or hide the Toolbox. User preferences are
described in the "ElixirForm defaults" chapter. Spell
check is described in the "Text operations" chapter.

Spell check

Long crosshair

Digital ruler

Grid
settings

Ruler on/off

Zoom

Show/hide
toolbox

Undo/Redo

Figure 2-3. Work area Toolbar
Menu bar
ElixirForm provides menus and sub-menus for accessing options. You must first select a menu button to
display a pull-down menu, then select an option.
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Creating a form
Following are suggestions you should consider when
creating a form.
Designing a new form
Sketching the form on paper before drawing it on the
screen makes element sizing and placement easier.
Reproducing an existing form
If you are creating a form from an existing form, have
the original form in front of you as you are recreating it
on the screen. Use a ruler to measure the margins,
lines and other form elements, then use the on-screen
rulers for precise placement of each element.
You can also use Elixir's ElixirScan product to scan an
existing form for conversion to Elixir format, then edit
the form using ElixirForm.
Designing a form to fit in a window envelope
If you are designing a form to fit a window envelope,
first sketch it, fold it and measure it against the envelope window to ensure proper display.
Designing a form for merged data
If your form will subsequently be merged with variable
data, print the formatted data to see how it prints on
the page; it is easier to design a form around data
than to redesign the form.
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Loading a form
ElixirForm allows you load a new or previously saved
form, or to merge form groups to create a new form.
Note that you can only load one form at a time into
ElixirForm.
Loading a new form <F9 >
To load a new form:
1.

Pull down the File menu and select [New
Form].
The Page Properties dialog box displays.

2.

Select page size, units of measure, color
mode and page offset options.
For information on the Page Properties dialog
box, see the "ElixirForm defaults" chapter.

3.

Click on [OK].
The Page Databasing dialog box displays.

4.

Enter optional information for the new form.
For information on the Page Databasing dialog
box, see the "ElixirForm defaults" chapter.

5.

Click on [OK].
A new, untitled form displays in the work area.

Loading a saved form <F8 >
ElixirForm allows you to retrieve a form previously
saved on the hard disk. If you are loading a form that
was created in a GEM version of ElixirForm, see
"Loading GEM forms" in this section before loading
the form.
To load a previously saved form:
1.

Pull down the File menu and click on [Load
Form].
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The Load Form dialog box displays.

Figure 2-4. Load Form dialog box
2.

Select the form you want to load.

3.

Click on [OK].
The form loads into the Work area.

If an image referenced in a form is missing, a replacement image displays. If you want to delete the image
from the form, select the replacement image and
press <Del>.
Loading GEM forms
If you are loading forms created using ElixirForm prior
to version 3.0, you can either maintain the original
boxed text formatting or use the new Windows box
text formatting. You can also either maintain the original color mode or select a new color mode.
For the currently loaded GEM form only, select
text formatting and color mode options using the
Text and Fonts options dialog box and the Page
Properties dialog box.
For all subsequently loaded GEM forms, select
text formatting and color mode options using the
GEM Forms Load Defaults dialog box.
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See the "ElixirForm defaults" chapter for information
about GEM Forms Load Defaults, Text and Font Options and Page Properties dialog boxes.
Merging a form group
ElixirForm allows you to merge a form into the current
work area without replacing work area contents. You
can thus save standard portions of a form such as
headers and footers, and reuse the elements as part
of a new form. See the "Grouping elements" section in
this chapter for more information about saving a form
group.
Note that ElixirForm will only merge objects that fit
within form boundaries; before using the [Merge Form
Group] option, ensure that there is sufficient work area
space available to prevent the elements from overlapping or falling outside form boundaries.
To merge a form group:
1.

Pull down the File menu and click on [Merge
Form Group].
The Load Form dialog box displays.

2.

Select the form you want to merge.
Although ElixirForm allows you to merge the currently loaded form with the same form, this is not
recommended as form elements may overlap.

3.

Click on [OK].

Note that you cannot undo a [Merge Form Group] operation.
Loading a form template
A form template is an .ELX form file that is loaded as
an overlay or visual guide for designing a new form.
However, the template does not become a part of the
new form; only the new form elements are saved.
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Note that while you can load more than one form file
template into the work area, retrieving multiple form
templates requires appreciably more memory.
Proof-printing a form comprising one or more templates also prints the templates. If you want to proofprint a form without the templates, save and reload
the form without the templates, then proof-print the reloaded form.
To load a form template:
1.

Pull down the File menu and select [Load
Form Template].
The Load Form Template dialog box displays.

2.

Select the template you want to use.

3.

Either click on [OK] or double-click on the
template name.

4.

Design the new form using the template as a
guide.

Adding form elements
You create forms in ElixirForm by adding elements
such as lines, paths, boxes, circles, text and images.
You can apply different attributes to any form element
by selecting options from the Toolbox. Elements can
be placed anywhere on the form; however, there is a
limit of 16 fonts, logos and graphics per form.
If you need to modify an element that is already on the
form, right-click on the element and apply new properties using options in the Toolbox.
For detailed information about adding or modifying a
form element, see the "Lines", "Shapes", "Text operations" or "Images" chapters.
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Using color
Form color usage depends upon the color mode of
the printer you use for final printing. You must specify
the color mode in ElixirForm before creating a form to
ensure that only the colors available on your printer
are used.
To specify form color mode:
1.

Pull down the Options menu.

2.

Select [Page Properties]
The Page Properties dialog box displays. See the
"ElixirForm defaults" chapter for more information.

3.

Select the color mode for the current form.

4.

Click on [OK].

Saving a form with a new name <F7 >
To save an existing form either with a different name
or to another directory:
1.

Pull down the File menu and either select
[Save Form As] or press <F7>.
The Save Form As dialog box displays.
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Figure 2-5. Save Form As dialog box.
2.

As appropriate, either enter a different name
in the file name box (you do not need to type
an extension), or assign a different drive:\ letter to the file.
Note that if you plan to convert the form to a different format, save the form with a maximum sixletter file name; longer file names truncate upon
conversion and can overwrite existing files.

3.

Click on [OK].

Saving a new form <Ctrl+S >
To save a new form:
1.

Pull down the File menu and either select
[Save Form] or press <Ctrl+S>.
The Save Form dialog box (similar to previous figure) displays.

2.

Enter a name in the file name box (you do not
need to type an extension).
Note tht if you plan to convert the form to a different format, save the form with a maximum sixletter file name; longer file names truncate upon
conversion and can overwrite existing files.
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3.

Click on [OK].

Modifying a form
After you create and save a form, you can later update
it or make a new form by modifying the form and saving it with a new name.
Editing elements
ElixirForm allows you to edit individual elements by
moving, copying or deleting form elements, and by
changing element properties.
To move, copy or delete an element, first rightclick on the element to select it, then perform the
desired operation.
To change the properties of an element, double
right-click on the element and make the changes
desired.
Note that editing procedures are similar for lines,
paths, boxes, circles, images and text, as described in
later chapters.
Shifting elements
You can shift all or only selected elements on a form.
Note that it is easier to see the elements shifting if you
first select the grid option.
To shift form elements, hold down the <Ctrl> key and
use the arrow keys to shift elements up, down, left or
right as desired. You can also shift elements using the
direction keys on the numeric keypad by first pressing
<Num Lock>.
Grouping elements
ElixirForm allows you to group form elements for editing purposes. A group comprises two or more elements. Once a group is defined, you can edit it as you
would a single form element.
ELIXIR FORMS EDITOR USER GUIDE
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Note that ElixirForm undoes a group one element at a
time. For example, if you delete a group and then click
on the Undo icon, the elements comprising the group
reappear one at a time.
Defining a group
You define a group by drawing a rectangular outline
around the desired elements.
To define a group:
1.

Select the Select/Edit tool in the Toolbox.

2.

Move the screen pointer near the elements
you want to group.

3.

Click on and drag the dotted line until it
encloses the desired elements.
Boxes appear around or inside each grouped element. Grouped text appears in square brackets.

Figure 2-6. Selected group elements
4.

2-12
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You can now move, copy or delete the group as a
single element.
To change the properties of one or more grouped
elements, right-click on the element(s) and select
desired properties from the Tool box.
You can also exclude any or all occurrences of a
grouped element:
To exclude all occurrences of an element,
select an element exception option before
grouping.
To exclude any one element from the group,
shift-click on the element after grouping.
To include the element again, shift-click on
the element a second time.
Saving a form group
ElixirForm allows you to select a group in an existing
form and save it as a separate form file. You can then
edit the file, or use it as a template for other forms.
This feature is helpful for reusing standard elements
such as headers and footers in other forms. You can
also merge selected elements from different forms to
create another form. See the "Merging a form group"
section in this chapter.
To save a form group,
1.

Define the group as described in the above
section.

2.

Pull down the File menu and select [Save
Form Group].

3.

Enter a filename.

4.

Click on [OK].
The form group saves to the forms directory
specified.
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Undo/redo feature
ElixirForm allows you to undo or redo an operation.
To cancel the most recent operation, select either the
Toolbar Undo icon or the Edit menu [Undo] option.
Note that when you cancel a group operation, ElixirForm undoes the operation one element at a time.
To cancel the most recent Undo operation, select either the Toolbar Redo icon or the Edit menu [Redo]
option.

Deleting a form
To delete a form:
1.

Pull down the File menu and select [Delete
Form]
The Delete Form dialog box displays.

Figure 2-7. Delete Form dialog box
2.

Select the name of the form you want to
delete.

3.

Click on [OK]
The form deletes.
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Renaming or moving a form
To rename or move a form:
1.

Pull down the File menu and select [Rename/
Move form].
The Rename/Move Form dialog box displays.

Figure 2-8. Rename/Move Form dialog box
2.

Select the form you want to rename or move.

3.

Click on [OK]
A supplemental dialog displays the directory and
name of the form.

4.

Enter either a new directory name to move the
file or a new file name to rename the file.
Note that the form must have an .ELX extension if
you want to load it into ElixirForm.
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2-15

ELIXIRFORM BASICS

5.

Click on [OK].
The file is moved or renamed, as specified.

Proof printing a form
To proof print a form:
1.

Pull down the File menu and select [Print].
The Print dialog box displays.

Figure 2-9. Print dialog box
2.

Choose from the following print options:

Printer
Select a PCL 4 or compatible printer based on the following considerations.
Elixir HP Driver
Select this option for optimal Elixir form proofprinting, including increased printing speed and
the ability to print shaded boxes using HP printer
shading calls, store a form as a macro and call
printer-resident fonts.
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PCL 4
PCL 4 printers print a maximum page size of 8 x
10.33 inches. If your form boundaries fill an 8.5 x
11 inches page, the outer margins of your form
will not print on a PCL 4 printer.
For accurate positioning, shift the print image on
the page using the [Page Shift] option in this dialog box.
PDF format
If you installed Adobe's PDFWriter printer driver
on your PC, you can convert your form to PDF
format by selecting [PDF ON FILE:] from this window. When you select this option, you are
prompted for a directory and file name.
Set Elixir HP Driver as default printer
Select this option to set the Elixir HP Driver as the default printer.
Orientation
Select form print orientation; either [Landscape] or
[Portrait].
Page shift
Select [Page Shift] to shift proof printer output horizontally or vertically by the number of dots specified. The
Xshift moves your form horizontally; the Yshift moves
your form vertically.
Use a negative shift value to shift the print output to
the left or down, and a positive value to shift the form
up or right.
The default setting for the page shift is 0; however,
you may need to change the shift after some initial
testing. For a PCL 4 or compatible printer, the normal
or centered image value is Xshift = -60.
Copies
Select the number of copies you want to print.
Print to file
You can print a file to disk and proof-print the form
from the disk file. This allows you to proof-print a form
from any PC connected to one of the supported proof
printers with or without ElixirForm installed.
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To print a form to a disk file for proof-printing, all proof
printer versions of fonts used in the form must reside
on the proof printer.
Print Fonts as Graphic
Select to rasterize fonts as graphics. Note that this option requires less printer memory and may reduce
form printing time.
Load Fonts
Select one of the following font load options:
[Always] to download fonts every time form
printed.
[Once] to download fonts as soft fonts identified
by index number; fonts then managed by and accessed through the Windows [Print Manager]
option.
[Never] to not download fonts; instead, call the index number of soft fonts residing on printer.
If you select [Once] or [Never], make sure to use the
same font list in your form as on the printer; if not, the
index number may represent a different font.
3.

Click on [OK].

When you click on [OK], you are prompted to enter a
file name. Enter up to eight characters for the stem
name of the file and click on [OK].
ElixirForm creates a print file with a .PRN extension in
the drive:\ELIXIR\PRINTS\HPPRINT subdirectory.
To print a form that has been written to disk, exit ElixirForm and display the DOS prompt. Specify the directory of the print file, and use the DOS COPY command to copy the .PRN file to your active parallel port
(for example, LPT1).
COPY filename.PRN LPT1 <Enter>
where filename is the stem name of the disk file.
Use the COPY/B command when printing HP PCL
files from disk.
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Fast keys
Fast keys are available for many ElixirForm operations. ElixirForm fast keys display next to options in
pull-down menus. See the "Keyboard shortcuts" appendix for more information.

Exiting ElixirForm
To exit ElixirForm and return to the Desktop, either
pull down the File menu and select [Exit] or doubleclick on the file drawer in the top left corner of the
Desktop. If you have not saved the current form, you
are prompted to do so.

ELIXIR FORMS EDITOR USER GUIDE

2-19

3.

ElixirForm defaults

This chapter contains procedures for setting ElixirForm defaults. Although you can change settings for
each form, you will probably find that you can keep the
same defaults for most of your forms.

User preferences
This section describes the grid, rulers and long crosshair options. You use these options to obtain precise
form element measurement and placement within the
ElixirForm work area.
Note that icons representing these options appear in
the Toolbar above the work area.
Grid <F4 >
The grid helps you to accurately place form elements
in the work area. When displayed, the grid allows you
to specify whether form elements should snap to grid
lines or at points halfway between. The grid does not
print as part of the form.
Displaying/Hiding the grid
To display the grid, click on the top half of the Grid
icon in the Toolbar; to hide the grid, click on the icon
again.
You can also display the grid by pulling down the View
menu and selecting the [Grid] option. Note that a
check mark appears next to the option when it is selected. To hide the grid, deselect the option.
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Selecting grid properties
To select grid properties:
1.

Right-click on the Grid icon in the Toolbar.
The Grid Setting dialog box displays.

Figure 3-1. Grid Setting dialog box
2.

As appropriate, backspace over the existing
setting and/or enter a new setting for the following options.

Grid units
Set dimensions for the grid background. Initial (default) settings are 10 x 6 units if measure per inch.
When you change Grid units values, the Grid steps
option (below) also displays the new values.
Note that Grid units values are in the same unit of
measure as the ruler displays. Therefore, changing
the unit of measure for the ruler displays changes the
unit of measure for the Grid units display. Grid units
size remains unaffected.
Grid step
Set distance between grid points. Note that when you
change the Grid units setting (above), Grid step reflects the new values.
3-2

ELIXIR TECHNOLOGIES CORPORATION

ELIXIRFORM DEFAULTS

Note that Grid step values are in the same unit of
measure as the ruler displays. Therefore, changing
the unit of measure for the ruler displays changes the
unit of measure for the Grid step display. Grid step
size remains unaffected.
Ruler display
Select to set Ruler units of measure to either [Inches],
[Centimeters], [Millimeters], [Dots], [Points] or [Pels].
Graphic Ruler in Grid Units
Select to set graphic Ruler units of measure to [Grid
Units] values. For example, if [Grid Units] is set to
8.00 per 1 inch for the horizontal setting and 6.00 per
1 inch for the vertical setting, the horizontal graphic
ruler displays 8 divisions (grid units) per inch and the
vertical graphic ruler displays 6 divisions (grid units)
per inch.
Digital Ruler in Grid Units
Select to set digital Ruler units of measure to [Grid
Units] values. For example, if [Grid Units] is set to
6.00 per 1 inch for the horizontal setting and 8.00 per
1 inch for the vertical setting, the horizontal digital
ruler displays 6 divisions (grid units) per inch and the
vertical digital ruler displays 8 divisions (grid units) per
inch.
Grid Snap to
Select to resize form elements (e.g., lines, boxes) to
fit the grid. Select [Full Grid] to snap to grid points; select [Half Grid] to snap to points halfway between grid
points.
Grid Color
Set grid color: [Black], [Dark Shade] or [Green].
Snap mouse speed
Set mouse snap speed: [Slow], [Moderate] or [Fast].
Show Grid <F4 >
Select to display grid; deselect to hide grid.
Snap to Grid <F5>
Select to place form elements per [Grid Snap To] setting (either on grid lines or points halfway between).
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You can also select the Snap to Grid feature by clicking on the Snap to Grid icon in the Toolbar or by pulling down the Options menu and selecting [Snap to
Grid]. See the "Snapping elements to the Grid" section in this chapter for more information.
To snap form elements to the grid, click on the bottom
half of the Grid icon. Specify whether the elements
should snap to the grid lines (Full Grid) or to points
halfway between (Half Grid) in the Grid Properties dialog box. See the "Selecting Grid properties" section in
this chapter for more information.
When the [Snap to Grid] option is selected, text snaps
as a block to the nearest grid point.
You may want to deselect [Snap to Grid] when working with text or graphics requiring free placement;
when [Snap to Grid] is deselected, elements are free
floating and can be placed at any point in the work
area.
3.

When finished selecting options and/or default settings, click on [OK].

Rulers <F3>
To display the graphic ruler at the top and left edges
of the work area, either click on the Ruler icon in the
Toolbar or pull down the View menu and select
[Ruler]. Note that a check mark appears next to the
option when selected.
The digital ruler displays at the top left of the Toolbar
and shows the horizontal and vertical position of the
screen pointer. Note that when [Snap to Grid] is selected, the digital rulers show only the coordinates of
the grid points nearest to the screen pointer.
To show the position of an element relative to the
form, select the Select/Edit tool and move the cursor
to any area on the element. A second digital ruler displays in the Toolbar showing the horizontal and vertical start coordinates of the element. A third digital
ruler shows element width and depth.
Note that while rulers display on the screen, they are
not part of the saved or printed form.
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To set ruler options:
1.

Right-click on the Ruler icon.
The Ruler Options dialog box displays.

Figure 3-2. Ruler Options dialog box
2.

Select from the following options:

Ruler measure
Set ruler display unit of measure: [Inches], [Centimeters], [Millimeters], [Dots], [Points] or [Pels].
Ruler color
Set ruler color: [Light Gray] (may be [White] on some
monitors), [Dark Gray] or [Green].
Graphic ruler <F3 >
Select to display graphic rulers at the top and left side
of the work area; deselect to hide graphic rulers.
Digital ruler
Select to display digital ruler in the corner of the Toolbar; deselect to hide digital ruler. Note that the digital
ruler shows the position of the screen pointer relative
to the top left corner of the form, (0,0).
In Grid Units
Select to display rulers in units of measure specified
for [Grid Units] in the Grid Setting dialog box.
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Long crosshair <F6 >
The long crosshair helps you to more precisely place
form elements about the work area.
To use the long crosshair:
1.

Either click on the Long Crosshair icon in the
Toolbar or pull down the View menu and
select the [Long Crosshair] option.

2.

Place cursor onto the desired form location in
work area.

The long cross hair displays vertically and horizontally
from the cursor.
Zoom/pan
The zoom/pan feature allows you to move about the
form in magnified view.

Figure 3-3. Magnified view
Zoom bigger or smaller
To zoom into or out of a form area, click on the [+] or
[-] scroll arrow on either side of the Zoom icon in the
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Toolbar. You can also use the <+> and <-> keys on
the numeric keyboard to zoom in and out.
The highest form magnification is [+8x]; the lowest is
[-8x].
Panning
The pan feature allows you to move the form around
the work area. Use the keyboard arrow keys to pan
up, down, left or right.
Keyboard zoom/pan controls
Use the following keys for zooming and panning:
<+> (numeric keypad) to zoom in
<-> (numeric keypad) to zoom out
arrow keys to pan form about the screen
<Home> to pan to the top left of the form
<End> to pan to the bottom left of the form
<Ctrl> + <PgDn> to pan to bottom right of form
<Ctrl> + <PgUp> to pan to top right of form
<PgUp> to scroll up
<PgDn> to scroll down.

Page settings
This section describes procedures for setting form
page default values.
Selecting page properties
The Page Properties dialog box displays each time
you load a new form. To change displayed default
values:
1.

Pull down the Options menu and select [Page
Properties].

The Page Properties dialog box displays.
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Figure 3-4. Page Properties dialog box
2.

As appropriate, backspace over existing setting and/or enter a new setting for the following options.

Page size
Set form page size. Note that page width and length
values are in same unit of measure as rulers.
8.5 x 11
U.S. letter size/21.59 x 27.94 cm
8.5 x 14
U.S. legal size/21.59 x 35.56 cm
11 x 17
11 x 17 inches/27.94 x 43.18 cm
A4
8.27 x 11.69 inches/20.99 x 29.69 cm
A3
11.69 x 16.54 inches/29.07 x 42.00 cm
Custom
Desired form length and width size, other than
those listed above.
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Switch
Select to change form orientation (Portrait or Landscape) by reversing form width and height values.
Units of measure
Set units of measure for rulers and page size: [Inches], [Centimeters], [Millimeters], [Dots], [Points] or
[Pels].
Color Mode
Set form printing color option: [Black & White] or [Full
Color]. Note that if you select [Black & White], the
Toolbox [Color] option does not display.
Page Offset
Specify page offset as follows:
[Xoffset] to shift output right for portrait orientation and down for landscape orientation, by
number of units of measure shown.
[Yoffset] to shift output down for portrait orientation and right for landscape orientation,
by number of units of measure shown.
3.

When finished selecting options and/or default settings, click on [OK].

Exceeding form page size limits
When you change the size or orientation of an existing
form, some form elements may extend beyond the
page boundary. If so, when you click [OK] in the Page
Properties dialog box (above), the Objects Off Page
dialog box instead displays.

Figure 3-5. Objects Off Page dialog box
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The Objects Off Page dialog box lists by type (i.e.,
line, box, text, etc.) all form elements that extend beyond the page boundary. For each object so listed:
4.

Select one of the following options:

Delete
Select to delete entire object from form.
Ignore
Select to increase page size to accommodate object.
Move in
Select to move object inside page boundary. Note that
form objects may now overlap.
Clip
Select to eliminate only that portion of object that is off
page.
5.

When finished selecting options, click on
[OK].

Page databasing
The Page Databasing dialog box displays each time
you select [New Form] from the File menu. The information is stored with the form until it is either changed
or deleted; however, it does not print with the form.
To add, change or delete databasing information for a
form:
1.

Pull down the Options menu and select [Page
Databasing].

The Page Databasing dialog box displays.
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Figure 3-6. Page Databasing dialog box
2.

Add or modify information for the following
options:

Short Page Description
Maximum 60-character form name or description.
Page Author
Maximum 8-character User ID of person who created
form.
Made for
Maximum 13-character name of customer for whom
form was created.
Page Version
Maximum 2-character version number of form.
Page Revision
Maximum 1-character form revision identifier.
Local ID
Maximum 8-character code or alternate name identifying form.
Long page comments
Maximum 240-character description of form purpose,
use of content.
Store date/time stamp
Select to assign form a date or time stamp when generated to printer file format.
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Date format
Selected [Store date/time stamp] date format.
sc:
Date format separator. Default is / (i.e., MM/DD/YY).
Time format
Selected [Store date/time stamp] time format.
sc:
Time format separator. Default is : (i.e., hh:mm:ss).
3.

When finished selecting options, click on
[OK].

Text and font options
To specify form text and font default settings:
1.

Pull down the Options menu and select
[Text/Fonts Options].
The Text and Font Options dialog box displays.

Figure 3-7. Text and Font Options dialog box

3-12

ELIXIR TECHNOLOGIES CORPORATION

ELIXIRFORM DEFAULTS

2.

Select from the following options:

Text tab length
Select to set length of all text tabs on current form.
Default length is 5.
Track text with cursor <F11>
Select to place imported text blocks at different locations on the form.
When selected, imported text attaches to the screen
pointer when you press and hold the left mouse button. You can drag the text as a block, then release the
mouse button to place the text on the form.
When deselected, imported text is locked into position
to allow you to load a text block and move the screen
pointer before loading the next text block.
When loading text, you can toggle between free text
and locked text by using the <F11> fast key.
See "Text operations" chapter for more information.
Sort Font List
High speed printers expect form definition font calls to
match printer disk font order.
Select this option when printing forms to disk on a
high speed printer. Note that this setting slows
down initial form display while the font list is being
sorted; use only when needed.
Deselect this option when printing forms to a
proof printer.
Text Formatting Compatibility and Grid Step Precision
Specify text format and grid step precsion for the currently loaded form:
[GEM]
Select to maintain the original boxed text formatting and grid step precision of 0.1 dots; for forms
created prior to ElixirForm 3.0.
[Windows]
Select to use Windows boxed text formatting and
grid step precision of 0.01 dots; recommended for
forms created in ElixirForm 3.0 or higher.
ELIXIR FORMS EDITOR USER GUIDE
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Join text using
ElixirForm allows you to group blocks of text into a
single paragraph. The [Join Text Using] option allows
you to specify how you want text to be joined.
[Spaces]
Select to display each text block under previous
text block; retains original line beginnings and
endings
[Justify]
Select to join and display text as one continuous
paragraph; joined text width is determined by the
position of the left- and right-most text block characters.
To remove unwanted spaces, deselect the Text
Toolbox [Wrap Text] option, then select the option
again.
[Relatives]
Select to retain text block dot-to-dot correspondence with first text block. Note that you can then
perform paragraph formatting operations, such as
justify or center, only when the [Wrap Text] option
is selected.
If reformatting wrapped text, deselect the Text
Toolbox [Wrap Text] option, then select the option
again.
For more information about text joining, see the "Text
operations" chapter.
Keyboard Mapping
The default for keyboard mapping is [KMP].
[None]
Select to use Windows ANSI mapping; requires
that screen fonts are mapped to Windows ANSI
mappings. Recommended when using TrueType
or ATM fonts.
[OEM]
Select to remap ANSI keystrokes to DOS mappings.
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[OEM/ISO]
Select to remap ANSI character strokes to DOS
ISO mappings. Note that this option is the same
as [Map IBM to ISO fonts] in ElixirForm versions
prior to 3.0.
[KMP]
Select to translate keystrokes using customized
tables. Note that this requires that you also select
the following Windows and Elixir options:
Windows
Select [T100ANSI] or, if using an Eastern European version of Windows, select [T10EEURO].
Other options are for future implementation.
Elixir
Select the setting that matches your DOS code
page. To check your DOS code page, go to the
DOS prompt and type
CHCP <Enter>
The active code page displays.
Text Import/Paste Mapping
The default is [NONE]. Note that only the [NONE] or
[KMP] setting is recommended.
[NONE]
Select when importing a DOS text file or when using TrueType or ATM fonts.
[OEM]
Select when importing a Windows text file.
[OEM/ISO]
Select when importing a Windows text file that
has mapped European characters.
[ISO]
Select when importing a DOS text file that has
mapped European characters.
[KMP]
Select when importing a Windows text file that
has mapped international characters. Note that
this requires that you also select the following
Text file and Elixir options:
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Text file
Select [T100ANSI] or, if using an Eastern European version of Windows, select [T10EEURO].
Other options are for future implementation.
Elixir
Select the setting that matches the DOS code
page. To check your DOS code page, go to the
DOS prompt and type
CHCP <Enter>
The active code page displays.
Spell Checker Mapping
Specifies the spell checker character mapping option.
[None]
Select to use Windows ANSI mapping; requires
that screen fonts are mapped to Windows ANSI
mappings. Recommended when using TrueType
or ATM fonts.
[OEM]
Select to remap ANSI keystrokes to DOS mappings.
[OEM/ISO]
Select to remap ANSI character strokes to DOS
ISO mappings. Note that this option is the same
as [Map IBM to ISO fonts] in ElixirForm versions
prior to 3.0.
[KMP]
Select to translate keystrokes using customized
tables. Note that this requires that you also select
the following Windows and Elixir options:
Windows
Select [T100ANSI] or, if using an Eastern European version of Windows, select [T10EEURO].
Other options are for future implementation.
Elixir
Select the setting that matches your DOS code
page. To check your DOS code page, go to the
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DOS prompt and type
CHCP <Enter>
The active code page displays.

GEM form defaults
For forms created using ElixirForm prior to version
3.0, you can use the GEM Forms Load Defaults dialog
box to specify desired text formatting, grid step precision and color mode settings. These settings then apply to all subsequently loaded GEM forms.
To change settings for the currently loaded GEM form
only, see the "Selecting page properties" and "Text
and font options" sections of this chapter.
To access GEM Forms Load Defaults dialog box:
1.

Pull down the Options menu and select [GEM
Forms Load Defaults].

The GEM Forms Load Defaults dialog box displays.

Figure 3-8. GEM Forms Load Defaults dialog box
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2.

Select from the following options:

Extend Lines by Halfwidth
Select to display horizontal and vertical lines with extensions equal to half the line thickness at each end.
This allows for more even appearance of intersecting
lines.
Note that selecting this option affects screen display
only; lines are stored as actually drawn.
Text Formatting Compatibility and Grid Step Precision
Specify text format and grid step precision for the currently loaded form:
[GEM]
Select to maintain the original boxed text formatting and grid step precision of 0.1 dots.
[Windows]
Select to use Windows boxed text formatting and
grid step precision of 0.01 dots.
3.

When finished selecting options, click on
[OK].

Configuring the system
ElixirForm allows you to configure your system and to
save the configuration for subsequent work sessions.
Setting usage defaults
To specify ElixirForm usage settings:
1.

Pull down the System menu and select [Usage
Switches].
The Usage Switches dialog box displays.
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Figure 3-9. Usage Switches dialog box
2.

Select from the following options:

Save State on Exit
Select to save menu and option settings when exiting
a form.
Show Quick Help
Select to display a short description of an icon as the
cursor passes over it. Descriptions display in the
Quick Help message area directly below the ElixirForm window main title bar.
Extend lines by half width
Select to display horizontal and vertical lines with extensions equal to half the line thickness at each end.
This allows for more even appearance of intersecting
lines.
Note that selecting this option affects screen display
only; lines are stored as actually drawn.
Show lines as WYSIWYG
[240DPI]
Select to display lines and borders as WYSIWYG;
recommended for high resolution monitors only.
[300DPI]
Select to display 300 DPI lines and borders as
240 DPI, the line and border thickness used in
AFP conversions.
[OFF]
Select if you have a low resolution monitor, such
as VGA.
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3.

When finished selecting options, click on
[OK].

Filing options
To specify form saving and filing options:
1.

Pull down the System menu and select [Filing
Options].
The Filing Options dialog box displays.

Figure 3-10. Filing Options dialog box
2.

Select from the following options:

Autosave
Select to automatically save your form at regular intervals; specify a time interval from 1 to 9 minutes.
Note that you can also save the changes to your form
manually by pressing <Ctrl> + <S> or by pulling down
the File menu and selecting [Save Form].
Make backup file
Select to create a backup copy of the form you replace by a save operation. The backup file is written to
the default forms directory and has the same stem
name as the original file, but with a .BAK extension.
Note that you must select this option before saving the
form.
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Load last form
Select to load the last form you worked on when starting ElixirForm from the Desktop; if option not selected,
a new, untitled form displays when ElixirForm is
started.
Forms directory
Specify a directory for your .ELX forms. The default is
drive:\ELIXIR\FORMS\ELIXIR\DEMO. If you change
the forms directory, ensure that the new directory already exists.
Fonts directory
Specify a directory for your Elixir format screen font
(.FNT) files and width (.WDT) tables. The default directory is drive:\ELIXIR\FONTS\SCREEN\DEMO. If
you change the fonts directory, ensure that the new
directory already exists.
Texts Directory
Specify a directory for imported ASCII text (.TXT) files.
The default directory is drive:\ELIXIR\TEXTS.
Tags Directory
If you are a DataMerge or DocuTag user and your
form contains tags for use with an external tag attribute file, specify a name for the external tag attribute
file. The default directory is drive:\ELIXIR.
3.

When finished selecting options, click on
[OK].

Resetting to defaults
To reset Toolbox options to default values:
1.

Pull down the System menu and select [Reset
to Defaults].

2.

Click on [OK].

Saving a configuration
To save the configuration settings specified above:
1.

Pull down the System menu and select [Save
Configuration].
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The configuration is saved for the next time you open
ElixirForm. However, if the font and screen directories
are changed in the Elixir Desktop, the changes will apply to ElixirForm the next time it is loaded.
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Lines

This chapter describes how to draw and edit lines using ElixirForm.

Line display
The following section provides general information
about line display in the ElixirForm work area.
Setting the screen display
If you are using a low resolution monitor such as VGA,
you should set the [Show Lines as WYSIWYG] option
in the Usage Switches dialog box to [Off]; if you do
not, thin lines and borders may display the same
thickness as medium lines and borders.
See the "ElixirForm defaults" chapter for more information.
Refreshing the screen
After a screen refresh, overlapping lines and boxes
may not display or print in the "front to back" order in
which they were drawn. For example, a shaded box
drawn on top of an existing line may display with the
line on top of the box after a screen refresh operation.
This is due to the page resorting method (from top left
to bottom right) required by certain printers.
To prevent elements refreshing to an incorrect "front
to back" order, avoid drawing elements that overlap.
For example, to draw a box with lines extending from
its borders, connect individual lines to the border of
the box instead of drawing the box on top of a line that
extends beneath and beyond its borders.
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Drawing lines
ElixirForm allows you to draw vertical, horizontal and
free lines. You can also specify line thickness, style
and color by selecting options from the Toolbox.
To display options for lines, either select the Toolbox
Line tool or pull down the Tools menu and select
[Line]. The Line toolbox displays.

Figure 4-1. Line toolbox
To start and end a line at grid points, click on the Toolbar [Show Grid] and [Snap to Grid] options.
If you want the line to snap to grid mid-points as well
as to grid points, set the [Grid Snap] option in the Grid
Setting dialog box to [Half grid]. See the "ElixirForm
basics" chapter for more information.
To draw a line:
1.

Position the screen pointer in the work area
where you want the line to begin, then press
and hold the left mouse button.

2.

Begin the line by dragging the screen pointer
across the work area.
A line displays.

3.
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The line locks into position.
You can apply properties to a line by selecting options
from the Line toolbox:
Line Direction
Select a direction for the line: [Horizontal only], [Vertical only], [Horizontal and Vertical] or [Free].
Line Width
Select a width for the line: [Thin] 2 dot, [Medium] 4 dot
or [Thick] 6 dot line widths. You can also click on the
up or down scroll arrow to increment line width by one
dot, or click on the current width display and enter a
new line width value up to 99 dots.
Line Style
Select a style for the line: [Solid], [Dashed] or [Dotted].
Line Color
If your printer supports color, select a color for the line
as follows:
1.

Select the color option.
If you cannot see the color option, select the Page
Properties dialog box [Full Color] option.
The Color dialog box displays.

2.

Select a color.

3.

Place the cursor in the work area and draw a
line.

The line displays in the color you selected.
Note that all subsequently drawn lines display the
same color until you select another color. Line color
selections are saved with the form when you select
[Save].
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Editing lines
To select a line for editing:
1.

Click on the Toolbox Select/Edit tool.

2.

Place the cursor on the line you want to edit.

3.

Click the right mouse button.
Boxes appear at each end of the selected line.
The Line toolbox displays.

You can now change the line length and attributes.
Changing line length
You can change the length of a line by either entering
new position coordinates or modifying it directly on the
form.
To change line coordinates:
1.

Click on the Toolbar current values window.
If you cannot click on the current values window,
select the line again and click the right mouse
button.

2.

Either backspace over current value(s) or
press the <Del> key to delete the value(s).

3.

Enter new coordinate value(s) for the line
selected.
If allowed, you can use the <-> key to enter a
negative value.

The line adjusts to the new coordinates when you either click the left mouse button or press <Enter>.
To manually change line length:
1.

Place the cursor at the end of the selected
line.
The cursor changes to a four-way arrow.
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2.

Drag the end of the line until it reaches the
desired length.

3.

Release the mouse button.
The changed line locks into position.

Sticky Lines <Ctrl> + <L>
When you select the Sticky Lines option, perpendicular connected lines stick together when you either
move one of the lines or change line size. Lines connected to form the sides of boxes also remain attached when you either move or resize the box. If you
deselect the Sticky Lines option, only the selected line
is affected by subsequent line moves or size changes.
Note that you must select either the [Horizontal only]
or [Vertical only] option in the Toolbox when moving
sticky lines. However, this requirement does not apply
when moving or resizing boxes.
To create sticky lines:
1.

Select the Sticky Lines option; either press
<Ctrl>+<L> before drawing a line or select a
line and then press <Ctrl>+<L>.

2.

As required, select either the [Horizontal only] option to restrict vertical line movement
right or left or the [Vertical only] option to
restrict horizontal line movement up or down.

3.

As required, resize a box either horizontally by
moving its left or right side or vertically by
moving its top or bottom side.

4.

Release the mouse button.
The sticky line or box locks into postion.

Changing line attributes
To change line width, style or color:
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1.

Select a line. To change the attributes of
multiple lines, shift-click on each line or use
the group feature described in the "Elixir
Form basics" chapter.

2.

Select the desired option(s) from the Line
toolbox.

The properties apply to the line(s) you selected.

Copying lines
To copy a line:
1.

Select the Toolbox Select/Edit tool.

2.

Select the Toolbox [Copy] option.

3.

Select the direction for copying: [Horizontal
only], [Vertical only] or [Free].

4.

Select the line you want to copy.
Boxes appear on the line when selected.

5.

Select the desired number of copies (99 maximum) by either clicking on the up or down
arrows or clicking on the numeric display box
and entering a new number.
Note that holding down the <Ctrl> key while clicking on the arrows increases or decreases the
value displayed by 10.

6.

Select the line and drag it to where you want
the duplicate line(s) placed.

7.

Release the mouse button.
The duplicate line(s) lock into position.
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Moving lines
To manually move a line:
1.

Select the Toolbox Select/Edit tool.

2.

Select the direction for moving: [Horizontal
only], [Vertical only] or [Free].

3.

Select the line you want to move.
Boxes appear on the line when selected.

4.

Click again on the selected line.
The screen pointer changes to a hand.
If the screen pointer does not change to a hand,
press and hold the <Ctrl> key as you move the
cursor over the line. When the screen pointer
turns into a hand, you can move the line.

5.

Drag the line to the new position.

6.

Release the mouse button.
The line locks in the new position.

To move a line by entering new coordinates:
1.

Click on the Toolbar object coordinates window.
If you cannot click on the current object coordinates, ensure you selected the line and click the
right mouse button.

2.

Backspace over the current values or press
the <Del> key to delete the current values.

3.

Enter new coordinate values.

4.

Either click the left mouse button or press
<Enter>.

The line adjusts to the new coordinates.
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Note that if the sticky lines option is selected, connecting lines and lines attached to the sides of boxes remain attached when one of the lines or the box is
moved. See the "Sticky Lines" section in this chapter
for more information.

Deleting lines <Del>
To delete a line:
1.

Select the Toolbox Select/Edit tool.

2.

Select the line you want to delete.
Boxes appear on the line when selected.

3.

Either press the <Del> key or pull down the
Edit menu and click on the [Delete] option.
The line is deleted.

To restore a line immediately after deletion, either select the Toolbar Undo icon or pull down the Edit menu
and click on [Undo].
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Shapes

This chapter describes how to draw and edit shapes
using ElixirForm.

Drawing shapes
ElixirForm allows you to draw paths, boxes and circles, and to apply attributes to these shapes by selecting options from the Toolbox.
If you want a box or path to start and end at grid
points, select the Toolbar [Grid] and [Snap to Grid]
icons.
If you want a box or path to snap to grid mid-points as
well as to grid points, set the Grid Setting dialog box
[Grid Snap to] option to [Half Grid].
To draw a shape, click a Toolbox shape tool and select the options for the shape.
Drawing paths
ElixirForm allows you to draw free paths or paths that
snap to horizontal and vertical lines. You can specify
path properties by selecting Path toolbox options.
To display the Path toolbox, either select the Path tool
or pull down the Tools menu and select [Path]. The
Path toolbox displays.
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Figure 5-1. Path toolbox
You draw a path in segments. To draw a path:
1.

Move the screen pointer into the work area.

2.

Click the left mouse button and drag the
screen pointer to draw the first path segment.

3.

Release the mouse button to finish the segment.

4.

Draw the next and subsequent segments by
repeating the above procedure.
Note that the next segment begins where the last
segment ends.

5.

End the path either by double-clicking the left
mouse button or selecting the [Draw/Done]
option.
Apply path properties by selecting options from
the Path toolbox:
Path Shape
Select open or closed paths. An open path remains open and a closed path auto- matically
closes when you finish drawing the path.
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Path Direction
Specify either [Snapped] or [Free] line
segments.Select [Snapped] to draw lines that
snap to horizontal and vertical lines; select [Free]
to draw line segments that run in any direction.
Path Beginning and End Styles
Select a line beginning and end style: Square,
round or mitered ends.
Border Width
Select standard [2], [4] or [6] border widths. You
can also click on the up or down arrow to change
the border width by one dot, or click on the current value and enter a new border width value up
to 99 dots.
Border Style
Select [Dotted], [Dashed] or [Solid].
Draw/Done Mode
When you click in the work area to add a path,
you are in [Draw] mode. When you complete a
path, select the Draw/Done option to toggle to
[Done] or double-click the left mouse button in the
work area. You can then draw another path or
switch to another mode.
Path Shading
The [Path Shading] option allows you to apply
shaded patterns to closed paths. Select the [Path
Shading] option. The shading dialog box displays
the available shade patterns. To select a shade,
click on a shade pattern. This shade pattern applies each time you draw a new closed path until
you change it using the same procedure. Select
the white shade box for no shading.
Corner radius
Select a path corner radius by clicking on the radius window up or down arrows to increase or decrease value by one pel. The maximum value is
299 pels.
6.

When path completed, either toggle the Draw/
Done option to [Done] or double-click the left
mouse button in the work area.
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Drawing boxes
ElixirForm allows you to create split boxes (i.e., one
box evenly divided or split into two or more boxes),
shaded boxes and boxes with varying borders and
styles.
To draw a box:
1.

Click on the Toolbox Box icon.
The Box toolbox displays.

Figure 5-2. Box toolbox
2.

Position the screen pointer in the work area
where you want a box corner.

3.

Press and hold the left mouse button.

4.

Drag the screen pointer to form the shape of a
box.

5.

Release the mouse button to finish the box.

Note that you can use the arrow keys to pan around
the screen when drawing a box that exceeds work
area boundaries.
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6.

Apply box properties by selecting options
from the Box toolbox.
Box corner Style
Select the box corner style. The corners can be
90 degrees, rounded, rounded at the top only,
rounded on the bottom only, rounded on the left
only or rounded on the right only.
Box Positioning
Select the top half of the [Box Positioning] option
to center the top left corner of the box on grid coordinates or select the bottom half of the option to
snap the top left corner of the box flush to grid coordinates.
Box Shape
Select the top half of this icon to draw boxes as
rectangles. Select the bottom half of this icon to
draw boxes as squares.
Box Diagonals
Select the diagonal line pattern for inside the box.
Each option displays a sample box.
Box lines
Select one or more of the following options to set
the box line width and style:
To set the box line width, use the up or down arrows in the numeric display box, or click in the
box and enter a new value. The maximum width
is 99 dots. Specify [0] if you want to apply an invisible border to a shaded box. Unshaded boxes
must have a border width of [1] or higher.
To set a box line to a standard [2], [4], or [6] dot
width, select the corresponding Border Width
option.
To set the box line style, select the [Solid],
[Dashed] or [Dotted] option.

7.

Select one of the following options to correspond to above width and style selections:
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Border Lines
Select to set the width and style of box borders
(and diagonals, if selected).
Horizontal Lines
Select to set the width and style of horizontal
splits in a box (see Box Splits, below).
Vertical Lines
Select to set the width and style of vertical splits
in a box (see Box Splits, below).
Box Splits
The [Horizontal Splits] and [Vertical Splits] options divide a box horizontally or vertically up to 40 even portions. Select the [Horizontal Splits] or [Vertical Splits]
option and specify the number of portions in the numeric display box next to each option. Use the up and
down arrows to increase or decrease the value by
one, or click in the box and enter a new value. Note
that the minimum value is 1 (hollow) and the maximum value is 40.
Box Shading
Select the [Box Shading] option to apply shaded patterns to boxes. The Shading dialog box displays the
available shade patterns. To select a shade, click on a
shade pattern. All the boxes you draw contain this
shading until you change it using the same procedure.
Select the white shade box for no shading.
Corner Radius
Select an option for the radius of the corners. Customize the radius by clicking on the up or down arrow
to increase or decrease the corner radius by one pel.
The maximum value is 299 pels.
The [Corner Radius] option does not apply when all
corner styles are 90 degrees.
8.
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When shape completed, either toggle the
Draw/Done option to [Done] or double-click
the left mouse button in the work area.
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Drawing circles
ElixirForm allows you to draw circles or circle segments as follows:
1.

Click on the Toolbox Circle tool.
The Circle toolbox displays.

Figure 5-3. Circle toolbox
2.

Move the screen pointer into the work area.

3.

Click the left mouse button and drag the
screen pointer to form a circle.

4.

Release the mouse button to finish the circle.

5.

Apply properties to a circle by selecting an
option from the Circle toolbox:
Circle Radius
Select any of the four segments to display that
segment of a circle. The radius you select corresponds to the starting angle and ending angle options.
Drawing Method
Select the top half of this button to draw a circle
from its center outward, where the anchor point is
the circle center.
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Select the bottom half of this button to draw a circle within an unseen box where the anchor point
is the box corner nearest the starting point. This
method allows you to be more precise in placing
the circle in relation to another element.
Diagonals
Select the diagonal line pattern for inside the circle. Each option displays a sample circle. Only
360-degree circles display diagonals.
Border Width
Select standard [2], [4] or [6] border widths. You
can also click on the up or down arrow to change
the border width by one dot, or click on the current value displayed and enter a new border width
value (up to 99 dots).
Border Style
Select the [Dotted], [Dashed] or [Solid] border
style.
Start and Finish Angle
Select the angle where you want your circle to begin and end. Use the up and down arrows to select the angle or backspace over the current value
and enter the new value.
Circle Shading
Select the [Circle Shading] option to apply shaded
patterns to circles. The Shading dialog box displays the available shade patterns. To select a
shade, click on a shade pattern. All the circles
you draw will contain this shading until you
change it using the same procedure. Select the
white shade box for no shading.
Circle Printing
Specify the style that dotted or dashed circles
print on the printer.
6.
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When circle completed, either toggle the
Draw/Done option to [Done] or double-click
the left mouse button in the work area.
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Editing shapes
To change the properties of a shape, you must first
select it.
To select a shape:
1.

Select the Select/Edit tool in the Toolbox.

2.

Place the cursor on the shape you want to
edit.

3.

Click the right mouse button.
The Toolbox displays the options for that shape.
Boxes appear around or inside the shape to show
it is selected.

Changing shape size
You can change the size of a selected shape by either
typing in new coordinates or modifying the shape directly on the form.
To change shape coordinates:
1.

Click on the current values displayed in the
toolbar.
If you cannot click on the current values, make
sure the shape is selected and click the right
mouse button.

2.

Backspace over the current values or press
the <Del> key to delete the whole number.

3.

Enter new coordinate values.
Use the <-> key to enter a negative value if
allowed.

The shape adjusts to the new coordinates when you
click the left mouse button or press <Enter>.

ELIXIR FORMS EDITOR USER GUIDE

5-9

SHAPES

To change a shape direcly on the form:
1.

Place the cursor on one of the boxes around
the shape.
The cursor changes to a double-ended arrow.

2.

Drag the cursor until the shape reaches the
new size.

3.

Release the mouse button.

Changing shape attributes
To change an attribute of a shape:
1.

Select a shape.

2.

Select an option from the shape's toolbox.
If the shape's toolbox is not displayed, make sure
the shape is selected and click the right mouse
button.

3.

To change the attributes of multiple shapes,
shift-click on each shape or use the "group"
feature described in the "ElixirForm basics"
chapter.

The properties you select apply to all the selected
shapes, if available.

Copying shapes
To copy a shape:
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1.

Select the Select/Edit tool in the Toolbox.

2.

Select the [Copy] option.

3.

Select the direction for copying: [Horizontal
only], [Vertical only] or [Free].

4.

Click on the shape you want to copy.
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Boxes appear on the shape to show it is selected.
5.

Click on the up or down arrows to select the
number of copies between 1 and 99.
Hold down the <Ctrl> key while clicking on the arrows to increase or decrease the value by 10.
You can also backspace over the value and enter
a new value from the keyboard.

6.

Click on the selected shape and drag it in the
direction you want to place the duplicate
shapes.

7.

Release mouse button.
The duplicate shapes lock into position.

Moving shapes
You can move a shape about the work area either
manually or by changing its coordinates.
To move a shape manually about the work area:
1.

Select the Toolbox Select/Edit tool.

2.

Select the direction for moving: [Horizontal
only], [Vertical only] or [Free].

3.

Click on the shape you want to move.
Boxes appear around the shape to show it is
selected.

4.

Click on the selected shape. The screen
pointer changes to a hand.
If the screen pointer does not change to a hand
when you place the cursor on the element, it may
be because the shape is too small. If this happens, press and hold the CTRL key as you move
the cursor over the shape. The screen pointer
turns into a hand and you can now move the
element.
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5.

Drag the shape to a new position.

6.

Release the mouse button.
The shape is locked in the new position.

To move a shape using coordinates:
1.

Click on the current values displayed in the
Toolbar.
If you cannot click on the current values, make
sure the shape is selected and click the right
mouse button.

2.

Backspace over the current values or press
the <Del> key to delete the whole number.

3.

Enter new coordinate values.

The shape moves to the new coordinates when you
click the left mouse button or press <Enter>.

Deleting shapes <Del>
To delete a shape:
1.

Select the Select/Edit tool from the Toolbox.

2.

Click on the shape you want to delete.
Boxes appear around the selected shape.

3.

Click on the [Delete] option or press the <Del>
key.
The shape is deleted.

4.

To restore a deleted shape, immediately click
on the Toolbar Undo icon or pull down the
Edit menu and select [Undo].
The deleted shape is restored.
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Text operations

This chapter describes ElixirForm text operations.

Creating text
You can create form text using either Elixir screen,
TrueType or ATM fonts. You can insert text either by
entering text directly from the keyboard or by importing text from an ASCII file.
You apply text properties by selecting options from the
Text toolbox.
To display the Text toolbox, select the Text tool or pull
down the Tools menu and select [Text]. The Text
toolbox displays.

Figure 6-1. Text toolbox
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Entering text from the keyboard
To enter text directly from the keyboard:
1.

Specify the text attributes from the Text
toolbox.

2.

Select a font from the font list.

3.

Click in the work area where you want the text
to appear.

4.

Enter characters from the keyboard.

5.

Click the right mouse button to finish entering
text.

To move a text block before you finish entering text:
1.

Press and hold down the <Ctrl> key.

2.

Place the cursor on the text block.

3.

Press and hold the left mouse button.

4.

Drag the text block to a new location.

5.

Release the mouse button to place the text.

To move a text block after you finish entering text, see
the "Moving text" section in this chapter.
Specifying text attributes
To specify text attributes, select from the following
Text toolbox options:
Text Rotation
Select the direction of the text: [Left to Right], [Bottom
to Top], [Upside Down] or [Top to Bottom].
Inter-character/Inter-word Spacing
The [Inter-character] and [Inter-word] options are
global features; if you select an option for one text
block, it will be applied to all text blocks in the form.
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These options are for display purposes only; you can
apply the [Inter-character] or [Inter-word] options to a
form only when you convert the .ELX file. See the
Elixir Desktop for AFP User Guide for more information.
Select [Inter-character] to justify all text blocks by increasing or decreasing space between characters.
This option makes the form easier to read when converting to OGL, but increases printing time.
Select [Inter-word] to justify all text blocks by increasing or decreasing the amount of space between
words. This option reduces form complexity to premit
faster printing.
Wrap Text
Select [Wrap Text] to keep text within the boundaries
specified in the width and height option. Always select
this option when using justified text.
Text Justification
To justify text, you must have the [Wrap text] option
selected. Specify the justification for each text block:
[Left Justified], [Center Justified], [Right Justified] or
[Full Justified].
Text Positioning
When the [Wrap text] option is selected, you can
specify the vertical positioning of a text block: [Top],
[Center] or [Bottom].
Use this option with [Text Justification] and [Box Text]
to place text in nine positions within the box.
Text Color
If supported by your printer, you can apply color to a
text block. Note that color selection applies to the
whole text block; you cannot color a single word.
To apply color to a text block:
1.

Select the Toolbox [Color] option.
The local palette displays.

2.

Select a color or shade from the palette.
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3.

Position the cursor in the work area and enter
text.

The selected color applies as you enter text, and continues for all subsequent text blocks until you select
another color.
Vertical Text Spacing
The text you type is vertically spaced by an LPI (lines
per inch) default value, depending on the font.
To change the vertical spacing, click on the up or
down arrow to increase or decrease the lines per inch
for the current font. You can hold down the <Ctrl> key
while clicking on the arrows to increase or decrease
the value by 1.0. This affects the current block of text
and any subsequent blocks of text entered using this
font.
To return the lines per inch to the default for this font,
use the down arrow to decrease the LPI value to [0] or
press the <Del> key.
Column Width and Height
Specify text block width and height. Make sure the
[Wrap text] option is selected when using this option.
When column width and height values are set to
[0.00], free text is bound by the width and height of the
form.
To enter a column width or height, either click in the
box and backspace over the current value or press
<Del> to delete the whole number. Enter a new value
from the keyboard. You can also use the up or down
arrows to increase or decrease the column width and
height. Hold down the <Ctrl> key while clicking on the
arrows to increase or decrease the value by 1.0. ElixirForm will not accept values that exceed the form
limits.
Boxed Text/Free Text (toggle)
ElixirForm allows you to enter text in predefined areas
or "boxes." You can define the box boundaries by entering values for the column height and width or by
drawing a box manually.
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To enter values for box boundaries:
1.

Select the [Box Text] option.

2.

Enter values for the [Column Width] and
[Column Height] options, as described above.

3.

Click in the work area.
A text box with the specified boundaries displays.

To draw a text box manually:
1.

Select the [Box Text] option.

2.

Select the [Draw Text Box] option.

3.

Place the cursor in the work area and hold
down the left mouse button.

4.

Drag the box and release the button at the
bottom right of the box.
Note that this box is not the same as one you
draw using the Box tool; rather, it is a visual aid
for defining the column width and height for a text
block only.

5.

Select the [Wrap text] option; set text positioning to [Top], [Center] or [Bottom].

6.

Enter text in the box; as required, press
<Enter> to insert carriage returns and begin
new paragraphs.

7.

When finished entering text, click the right
mouse button.

When the [Box Text] option is deselected, you can enter free text. Free text is bound by the width and
height of the form or by the width and height specified
in the [Column Width] and [Column Height] option. If
you use the [Column Width] and [Column Height option, make sure [Wrap text] is selected. When entering free text, press <Enter> to move to a new line.
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Specifying a font
ElixirForm allows you to select a font either from the
current list or one loaded from a new list. You can also
merge and save font lists.
Note the ElixirForm limit of 16 fonts per form.
Selecting a font from the current list
When you open a new (untitled) form, he current font
list displays in the toolbox preview panel. The current
font is highlighted. You can usually recognize the font
family and the size, style, and orientation of a font
from the file name.
The font list displays Elixir-format screen font files
(.FNT) in the screen fonts directory defined in the Filing Options dialog box. During installation, the default
screen fonts directory is set to drive:\ELIXIR\FONTS\
SCREEN\DEMO.
You can generate additional fonts for use in ElixirForm
using contour fonts. See the Elixir Desktop for AFP
User Guide for more information.
You can also create or edit fonts using ElixirFont
software.
To select a font from the current list, click on a font
name in the preview panel. Use the [Up] and [Down]
arrows on the keyboard or the scroll bar on the right of
the display window to scroll through the list.
Selecting a new font list
The [Font List Selector] option allows you to select a
new font list or merge lists and save it with a new
name.
To load a different font list:
1.

Click on the down arrow under the [Font List
Selector] option.
The Load Font List dialog box displays.
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Figure 6-2. Load Font List dialog box
2.

Select a font list and click on [OK].
The font list displays in the Toolbox preview
panel.

3.

Select a font as described previously in this
chapter.

You can merge the current font list with other font
lists, or add individual fonts from other lists .
To merge a font list with the current font list:
1.

Click on the double arrows under the [Font
List Selector] option.
The Merge Font List dialog box displays.

2.

Select the font list you want to merge.

3.

Click on [OK].
The fonts are added to the current font list.
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You can create and save your own custom font lists
for particular forms or groups of forms. To save a custom font list:
1.

Click on the up arrow under the [Font List
Selector] option.
The Save Font List dialog box displays.

2.

Either enter a new file name to save the list
with a unique name, or enter an existing file
name to overwrite the existing font list.

To add fonts to the current font list:
1.

Click on the [Font Type] option until desired
font type (A=ATM, TT=TrueType or F=Elixir)
displays.

2.

Click on [+] next to the [Add/Remove Font]
option.
Depending on [Font Type] selected, either the Select ATM Fonts, Select TrueType Fonts or Elixir
Add Fonts dialog box displays.

Figure 6-3. Add Fonts dialog box
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3.

Select the font you want to add.

4.

Click on [OK].
Repeat procedure for each font type and font you
want to add.

To remove a font from the current list:
1.

Highlight the font name in the preview panel.

2.

Click on [-].
The font is removed from the list. Note that you
cannot remove a font that is in use on your form.

You can also use <Ctrl> + <-> to delete all unused
fonts from the list.
Changing text block fonts and text attributes
To change the font and text attributes you are using in
a text block:
1.

Place cursor at text block start.

2.

Select a new font name from the font list.
Use the up and down arrows in the font display
window to scroll through the font list.

3.

Select text attributes from the Text toolbox.
The text you enter reflects the new font and text
attributes.

4.

Click right mouse button to end text entry.

To use different fonts within the same text block:
1.

Place cursor in text block where you want font
change to start.

2.

Select font from list in the Preview Panel.

3.

Enter new text.
Note that the new text reflects the new font while
previous text retains the original font.
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When you change the font as described above, a hidden control character is added just before the
changed text which contains font information. You can
delete the control character by placing the cursor at
the beginning of the changed text and pressing the
<Del> key. Deleting the control character changes the
text back to its original font.
Replacing fonts
To replace every occurrence of a font:
1.

From current font list, select the font you want
to replace.

2.

Click on [-] next to the [Add/Remove Font]
option.
Depending on font type being replaced, either the
Select ATM font, Select TrueType font or Replace
Font dialog box displays.

Figure 6-4. Replace Font dialog box
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3.

Select a replacement font from the displayed
font list.
If the replacement font is not currently in use on
the form, all occurrences of the font will be replaced by the replacement font.

If you click on [-] and the font is not in use in the document, the font is removed from the font list. See "Adding or removing a font" in this chapter for more
information on removing a font.
Entering non-standard characters
The soft keyboard allows you to enter characters that
are not available on a standard keyboard.

To type an extended character:
1.

Place the cursor in the work area where you
want the character to appear.

2.

Select the [Soft Keyboard] option.
The soft keyboard displays.

Figure 6-5. Soft Keyboard
3.

Select a character from the soft keyboard.
The character displays at the selected position.

4.

Deselect the [Soft Keyboard] option when
finished.

You can also access the non-standard keyboard characters by typing the decimal value of the non-standard
keyboard character. Press <Alt> and enter the decimal value using the numeric keypad.
The soft keyboard displays characters in the current
font size, so smaller fonts may be difficult to read. You
can change the current font to a larger point size, edit
using the soft keyboard, then change the text block
back to the smaller font after completing the edit.
ELIXIR FORMS EDITOR USER GUIDE
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Importing text
ElixirForm allows you to import ASCII text, one block
at a time, from the directory specified in the Filing Options dialog box. The default directory is drive:\
ELIXIR\TEXTS.
Before you import text:
Copy the ASCII file to the texts directory specified
in the Filing Options dialog box.
Assign the ASCII file a .TXT extension.
Separate paragraphs (or text blocks) with two carriage returns.
To import text:
1.

Select the Text tool in the Toolbox.
The Text toolbox displays.

2.

Specify [Locked Text] or [Free Text].
ElixirForm allows you to load text blocks directly
under the previous block of text, regardless of the
screen pointer position (locked text), or specify
the location of each text block by placing the text
block with the screen pointer (Free text).
Use the <F11> key to toggle between [Locked
Text] and [Free Text]. The message area at the
top of the ElixirForm Window displays the current
setting. (See the "ElixirForm basics" chapter for
specifying the default setting in the Text and Font
Options dialog box).

3.

Select text attributes from the Toolbox.

4.

Pull down the File menu and select [Import
text].
The Import Text dialog displays the files in the
drive:\ELIXIR\TEXTS directory.
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Figure 6-6. Import Text dialog box
5.

Select the file you want to load.

6.

Click on [OK].

7.

Press and hold the screen pointer to display
the first text block.
To scroll through the text blocks, hold down the
left mouse button and press the <F3> key to
scroll to the previous text block and the <F4> key
to scroll to the next text block.

8.

Drag the text and release the left mouse
button to place the first text block on the
form.

9.

Click the left mouse button to display and
place the next text block.
If [Locked Text] is selected, the text block will
load directly below the previous block; if [Lock
Text] is deselected (free text), the text block loads
wherever you place the screen pointer.

You can change the attributes of a text block by selecting the attributes from the Toolbox before importing each block.
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Importing text into a box
If you are importing text into a box, you must define
the text box size first. See the "Specifying text attributes" section in this chapter for information about
boxed text.
Text imported into a box does not maintain original
carriage returns; if you want ElixirForm to maintain
carriage returns from original text, you must deselect
the [Box Text] and [Wrap Text] options.

Data tags
ElixirForm allows you to add, edit and view Data tags
for use with DocuTag or DataMerge software.
See your DocuTag User Guide or DataMerge User
Guide for detailed information.

Editing text
When editing text, the name of the font used to create
the text is highlighted in the font list window. You must
select a text block before you can edit it.
To select a text block:
1.

Select the Toolbox Select/Edit tool.
You can also change to select mode by clicking
on the text with the right mouse button. However,
if you are still in add text mode, this right-click
ends text entry; you must right-click again to
change to select mode.

2.

Place the cursor on the text block you want to
edit.

3.

Click the right mouse button.
The Text toolbox displays.
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See the keyboard shortcuts listed at the end of this
chapter for use when editing text.
Changing text attributes
To change the attributes of a selected text block, select Text toolbox icons. Each new attribute is applied
to the selected text block.
Applying a different font to a text block
To change the font in a text block:
1.

Select the text block and click the right mouse
button.
The Text toolbox displays.

2.

Place the cursor at the beginning of the text
block.

3.

Select a font in the font list.
The new font applies to all text in the text block.

Applying multiple fonts to a text block
When editing text, the name of the font used to create
the text is highlighted in the font list window. If multiple fonts are used, the highlighted font changes as
you place the cursor on different fonts.
All fonts in the text block must have the same orientation. To use a font with a different orientation, place
the cursor at the beginning of the text block and apply
the orientation to all fonts within the block.
To change a font location to the end of the text block:
1.

Select the text block and click the right mouse
button.

2.

Place the cursor at the location where you
want the new font to start.

3.

Click the left mouse button.
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4.

Select a font from the displayed font list.
All text following the text cursor changes to the
selected font.

To change the font of a word or phrase in a text block:
1.

Select the text block and click the right mouse
button.

2.

Highlight the word or phrase you want to
change.

3.

Select a new font from the displayed font list.
The selected text reflects the new font.

Joining text
ElixirForm allows you to rejoin text that was broken up
when converting a form to .ELX format.
To join text:
1.

Pull down the Options menu and select
[Text/Font Options].
The Text and Font Options dialog box displays.

2.

Select the option for joining text: [Spaces],
[Justify] or [Relative].
See the "ElixirForm defaults" chapter for information about the Text and Fonts Options dialog box.

3.

Click on [OK].

4.

Group the text you want to join.
See the "ElixirForm basics" chapter for information about defining a group.
The Select/Edit toolbox displays .

5.

Select the [Join Text] option.
The text in the group is joined.
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Splitting text
To split a text block into two separate blocks:
1.

Select the text block and click the right mouse
button.
The Text toolbox displays.

2.

Place the cursor where you want the text to
split.

3.

Hold down the <Shift> + <Ctrl> keys while
clicking the left mouse button.
The text splits and the cursor displays in the upper left corner of the new text block.

See the "Moving text" section in this chapter to reposition the text block.
Moving text
You can move a text block either before or after entering text.
To manually move a text block:
1.

Select the Toolbox Select/Edit tool.

2.

Select the direction for moving: [Horizontal
only], [Vertical only] or [Free].

3.

Click on the text block you want to move.
The cursor changes to a hand.

4.

Place the cursor over the text block.

5.

Drag the text block to where you want it on
the form.

6.

Release the mouse button to accept the text
position.

You can also move the text block by entering new coordinates:
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1.

Click on the values displayed in the Toolbar
current object coordinates window.
If you cannot click on the current object coordinates, make sure the text block is selected and
click the right mouse button.

2.

Backspace over the displayed values or press
the <Del> key to delete the whole number.

3.

Enter new coordinate values.

4.

Click the left mouse button or press <Enter>.
The text adjusts to the new coordinates.

Copying text
To copy a text block:
1.

Select the Toolbox Select/Edit tool.

2.

Select the Toolbox [Copy] option.

3.

Select the direction for copying: [Horizontal
only], [Vertical only] or [Free].

4.

Select the text block you want to copy.
Brackets appear around the text to show it is selected.

5.

Either enter a value in [Copies] or click on the
up or down arrows to select the number of
copies between 1 and 99.
Hold down the <Ctrl> key while clicking on the arrows to increase or decrease the value by 10.
You can also backspace over the value and enter
a new value from the keyboard.

6.

Drag the block of text in the direction you
want to place the copies.

7.

Release the mouse button at desired location.
The copies lock into position in the work area.
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Cutting, copying and pasting text
ElixirForm uses hot-keys to cut and paste selected
text.
To cut or copy and paste text:
1.

Select the Toolbox Select/Edit tool.

2.

Select the text block with the right mouse
button.

3.

Highlight the text to be cut or copied.

4.

Cut or copy text. Press <Ctrl> + <X> to cut
text; press <Ctrl> + <C> to copy text.

5.

Click the right mouse button to end text
selection.

6.

Select the Toolbox Text tool.

7.

Click the cursor at the new location.

8.

Press <Ctrl> + <V> to paste text.

Deleting text
To delete text within a text block:
1.

Select the text block.

2.

Highlight the text to be deleted.

3.

Select the [Delete] option or press <Del>.
The selected text deletes.

To delete a text block:
1.

Select the text block.

2.

Select the [Delete] option or press <Del>.
The selected text block deletes.
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To restore deleted text, immediately either pull down
the Edit menu and select [Undo], select [Undo] in the
Toolbar or press <Ctrl + Z>.

Spell checking
If installed, the ElixirForm Spell Checker feature allows you to identify misspelled words in your form.
This section describes how to set up and use the
Spell Checker feature.
Spell Checker options
To set up the Spell Checker:
1.

Pull down the Options menu and select [Spell
Check Options].
The Spell Check Options dialog box displays.

Figure 6-7. Spell Check Options dialog box
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2.

Select from the following options:

Language
Select a language from the drop-down list that displays.
Dialect/mode
For the language specified, select a dialect from the
drop-down list that displays.
Ligature
Depending on language specified, this option may or
may not display. Select [Open] to print two-letter character combinations side-by-side; select [Closed] to
print two-letter character combinations together.
Lexicon Supplements
Available only if [English Standard] language option
specified. As appropriate, select either [Business/
Insurance/Finance], [Medical], [Legal] or [Science] to
use a dictionary containing related terminology.
Processing Correction Defaults
Select error correction defaults from the following
options:
[Provide Alternatives If Not Found] to use alternative
words when identified word is not found in the database.
[Provide Alterns. From Personal Dictionary] to use alternative words from a personal dictionary when identified word is not found in the database.
[Perform Space Insertion] to insert space(s) between
incorrectly spaced words. For example, to correct the
string "andthe" to "and the".
[Remove Final Period] to delete the final period from a
word before submitting it for correction.
Personal Dictionaries
Select from the following dictionary (*.RD) file options:
[New] to create a personal dictionary. Specify a name
for the dictionary in the Create Personal Dictionary
dialog box that displays.
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[Add] to add an existing personal dictionary (*.?D) file
selected from the Add Personal Dictionary dialog box
that displays.
[Remove] to delete a selected dictionary.
[Edit] to modify a selected dictionary . In the Edit Personal Dictionary dialog box that displays, use [Add],
[Replace] and [Delete] for the word displayed in the
[Edit word] option.
Spell Check Typing
Select to activate the Spell Checker after each word
you type; once you type a word and press the space
bar, the word is spell-checked.
Using the Spell Checker
To use the ElixirForm Spell Checker:
1.

Either click on the Toolbar Spell Check icon
or pull down the Tools menu and select [Spell
Check].
All text in the current form is checked for misspelled words.
If Spell Checker does not recognize a word, the
Spell Check dialog box displays. The unrecognized word displays in the {Edit] box; the possible
correct word displays in the [Guess] box.

2.

If the word displayed in the [Guess] box is not
correct, click on the [Guess] box down arrow
to display a list of alternative words.

3.

Select the correct word from those listed.

4.

If word not found in the [Guess] box list, place
cursor in the [Edit] box, backspace over
misspelled word and enter correct spelling.

5.

Select one of the following options:
[Replace] to use the word either displayed in the
[Guess] box or entered in the [Edit] box.
[Ignore] to overlook this occurrence of the word.
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[Ignore all] to overlook this and aqll subsequent
occurrences of the word.
[Add to] to add word to the selected dictionary.
[Stop] to halt Spell Checker operations for current
form.
A 'beep' indicates when a spell check operation
completes.

Keyboard shortcuts
ElixirForm uses the following fast keys for the text operations described in this guide:
<Left arrow>

Move cursor left one character

<Up arrow>

Move cursor up one line

<Right arrow> Move cursor right one character
<Down arrow> Move cursor down one line
<Home>

Move cursor to start of line

<End>

Move cursor to end of line

<Ctrl> +
<Left arrow>

Move cursor left one word

<Ctrl> +
<Right arrow> Move cursor right one word
<Ins>

Insert/Overwrite toggle

<Del>

Delete character right

<Backspace> Delete character left
<Ctrl> + <Del> Delete next word
<Ctrl> +
<Bksp>
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<Ctrl> + <E>

Delete to end of text block

<Ctrl> +
<End> Move cursor to end of text block
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<Ctrl> + <K>

Delete to end of line

<Ctrl> +
<Home>

Move cursor to start of text block

<F11>

Lock/free text

<Ctrl> + <T>

Show/hide data tags

<Ctrl> + <X>

Cut text

<Ctrl> + <C>

Copy text

<Ctrl> + <V>

Paste text
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ElixirForm uses Full-color and black-and-white Elixirformat images. You can use the Elixir Desktop to convert .PCX and .TIF files to Elixir format.
Screen versions of images have .LW8 extensions and
reside in the drive:\ELIXIR\PICS\SCREEN directory.
Printer versions of images have .LP3 extensions and
reside in the drive:\ELIXIR\PICS\PRINTER di- rectory.
For more information about creating Elixir-format images, see the ElixirImage for AFP User Guide.

Loading an image
You can load a maximum of 16 images or logos to a
form. The size allowed for an image depends upon
the amount of available memory in Windows and the
capability of your printer.
To add an image to your form:
1.

Select the Image tool in the Toolbox or pull
down the Tools menu and select [Image].
The Image toolbox displays.
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Figure 7-1. Image toolbox
The Image toolbox displays the [Load Image]
option.
Note that if an image is already loaded, the image
name, image coordinates, and an image preview
also display in the toolbox.
2.

Select the Toolbox [Load Image] option.
The Load Image dialog box displays images with
.LW8 extensions residing in the drive:\ELIXIR\
PICS\SCREEN directory. Note that these images
are for display purposes only and cannot be used
for conversions or printing.
To select an image with an .LP3 extension from
the drive:\ELIXIR\PICS\PRINTER directory, hold
down the <Ctrl> key and select the [Load Image]
option.
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Figure 7-2. Load Image dialog box
3.

Select an image and click on [OK]

4.

Press and hold the left mouse button.
The image attaches to the screen pointer.

5.

Position the image on the form, then release
the left mouse button.
The image locks into place.

Editing images
You can only edit images using ElixirImage software.
See your ElixirImage for AFP User Guide for more
information.

Moving an image
You can move an image on your form either manually
or by entering new position coordinates.
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To move an image manually:
1.

Select the Select/Edit tool in the Toolbox.

2.

Select the direction for moving: [Horizontal
only], [Vertical only] or [Free].

3.

Click on the image you want to move.
Boxes appear around the image when selected.

4.

Drag the image to the new location.

5.

Release the mouse button
The image locks into position.

To move an image by entering new coordinates:
1.

Click on the values displayed in the Toolbar
current object coordinates window.
If you cannot click on the current object coordinates, make sure the image is selected and click
the right mouse button.

2.

Backspace over the displayed values or press
the <Del> key to delete the whole number.

3.

Enter new coordinate values.

4.

Press <Enter>.
The image moves to the new coordinates.

Copying an image
To copy an image:
1.

Select the Toolbox Select/Edit tool.

2.

Click on the image you want to copy.
Boxes appear around the image when selected.

7-4

ELIXIR TECHNOLOGIES CORPORATION

IMAGES

3.

Select the Toolbox [Copy] option.

4.

Click on the up and down arrow to specify
number of copies.

5.

Select the direction for copying: [Horizontal
only], [Vertical only] or [Free].

6.

Drag the image in the direction you want the
duplicate images to display.

7.

Release the mouse button to lock the images
in the position desired on the form.

Deleting an image
To delete an image:
1.

Select the Toolbox Select/Edit tool.

2.

Click on the image you want to delete.
Boxes appear around the image when selected.

3.

Either click on the Toolbox [Delete] option,
pull down the Edit menu and select [Delete] or
click on the <Del> key.
The selected image is deleted.

To immediately undo the delete operation, either click
on the Toolbar Undo icon or pull down the Edit menu
and select [Undo].
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Stand-alone utilities

This chapter describes the Elixir stand-alone batch
utilities provided with ElixirForm. These utilities copy
to the drive:\ELIXIR directory during installation (drive:
is the drive on which you installed your Elixir
software).

Using the utilities
The parameters required to run each utility display on
your screen when you enter the utility name from the
drive:\ELIXIR directory.
Most utilities accept DOS wildcard characters (see
your DOS documentation for instructions on the
proper use of wildcards). When using wildcards, specify only the desired file(s).
For optional parameters enclosed in brackets [ ], the
first parameter is the default.
When specifying utilities, either do not specify parameters to use the parameter default or specify all
the parameters. You cannot skip parameters.
All utilities link to Desktop operations through dialog
boxes (note that not all utility options are available
from the Desktop dialog boxes). Note that application-specific utilities must be run on the command line
using the DOS pull-down menu or the Dispatcher
icon.
Add drive:\ELIXIR to the DOS PATH= statement in
your AUTOEXEC.BAT file to ensure that DOS
searches the drive:\ELIXIR directory for the batch utility. For details on setting up the PATH= statement,
see your DOS manual.
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AFPVIEW
The AFPVIEW utility displays the contents of AFPformat OVE, page segment and font files in hexidecimal and ASCII masked format.
Usage

AFPVIEW filename.ext <Enter>
filename.ext
is the AFP file name and extension.

Directory
information

Run AFPVIEW from the directory in which the AFP file
to be viewed resides.
OVE files are in
drive:\ELIXIR\FORMS\OVEIN or
drive:\ELIXIR\FORMS\OVEOUT.
Page segment files are in
drive:\ELIXIR PICS\SEGIN or
drive:\ELIXIR\PICS\SEGOUT.
Bounded-box fonts are in
drive:\ELIXIR\FONTS\AFPIN or
drive:\ELIXIR\FONTS\AFPOUT
Unbounded-box fonts are in
drive:\ELIXIR\FONTS\I38IN or
drive:\ELIXIR\FONTS\I38OUT.
When the file contents are displayed on the screen,
use the following keys:
<Page Up>, <Page Down>, <Home>, or <End> to
scroll through the pages.
The up, down, right and left arrow keys to mve
the cursor in the currently displayed page.
<J> and a number to jump to the page number.
<Alt> + <H> to display help.
<Alt> + <X> to exit the screen and return to DOS.
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FONTCHG
The FONTCHG utility does the following:
Strips the two left characters from Elixir-format
form files names
Substitutes fonts in an Elixir form with fonts you
specify in a font list
Lists information about fonts in an Elixir-format
form
Usage

FONTCHG filename [fontlist][-LIST]<Enter>
filename
is the Elixir-format form file name, with or without the
.ELX extension. Wildcards are allowed.
fontlist
is the full name and path of an ASCII font list file
Wildcards are not allowed. Each line of the font list file
contains a pair of Elixir fonts separated by a space.
When running the utility, fonts in the first column are
substituted with the corresponding font from the second column.
-LIST
displays a list of .ELX files specified by filename, and
for each .ELX file, lists the fonts used in the form. A
list of all fonts used in multiple forms (when using wildcards for filename) also displays.

Directory
information

Example

Run FONTCHG from the directory in which the files to
be converted reside. If you have not specified
drive:\ELIXIR in you DOS PATH= statement, precede
the FONTCHG command with drive:\ELIXIR.
To substitute fonts in the Elixir form MARK.ELX with
the fonts in the CHAD.LST ASCII font file list, type:

CD \ELIXIR\FORMS\ELIXIR <Enter>
The current directory (on the current drive)
changes to \ELIXIR\FORMS\ELIXIR.
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FONTCHG MARK.ELX
C:\ELIXIR\FORMS\ELIXIR\DEMO
CHAD.LST <Enter>
This command substitutes the fonts in the Elixir
form MARK.ELX with the fonts specified in the
ASCII font list file CHAD.LST in the \ELIXIR\FORMS\ELIXIR\DEMO directory.
(The fonts used in the form MARK.ELX are entered in
the first column of the ASCII font file, and the desired
substitution font is entered in the second column of
the file across from the font it will replace.)

FORMPRN
The FORMPRN utility prints Elixir format forms in
batch mode using MS-DOS commands.
Usage

FORMPRN [path] filename [HP]
[printer | disk] [copies] [ASCII] [macronumber] [traynumber] [land] <Enter>
path
is the optional DOS pathname.
filename
is any DOS file name, including the file extension.
Wildcards are allowed.
HP
is the optional printer type. (Only HP printer type is
supported in this release)
printer/disk
is the destination of the output file to a printer or
diskette.
copies
is the number of copies to be printed. The default is 1.
Note that font files are sent with every copy.
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ASCII
is the printer interface. Currently, only the ASCII interface is supported. Omitting or including this parameter has no effect.
macronumber
is the macro number used for HP printers. 0 = None.
traynumber
is the output tray number for printers supporting this
feature. The default tray is 0.
land
forces the orientation to landscape (for HP printers
only).
FORMPRN produces a .PRN file containing PCL 4
statements in ASCII format.
Directory
information

Run FORMPRN from the drive:\ELIXIR directory.
FORMPRN searches the default forms directory (usually drive:\ELIXIR\FORMS\ELIXIR\DEMO) as specified in the ElixirForm configuration file.

IC
The IC utility convers .LP3, .PCX, and .TIF format image files to .LP3, .PCX, screen or .TIF format files.
Note that all options are preceded by a hyphen ("-")
and can be entered in any order.
Usage

IC sourcefile [informat] [outformat] [-Dnn] [-Faaa]
[-Wa] [-Rnnn] [-Xnnn] [-Ynnn][-Saaa] <Enter>
sourcefile
is the filename of the source image. Wildcards are
allowed.
informat
is the name of the source image format: ELIXIR,
PSEG, PCPAINT, or TIFF.
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ELIXIR represents Elixir (.LP3) format image files. To
convert an Elixir image file, it must be in the
drive:\ELIXIR\PICS\PRINTER directory.
PCPAINT represents PCX format files. To convert a
PCX file, it must be in the drive:\ELIXIR\PICS\PCXIN
directory.
TIFF represents TIFF (.TIF) format files. To convert a
TIFF format file, the file must be in the
drive:\ELIXIR\PICS\TIFFIN directory.
outformat
is the name of the target image format: ELIXIR,
PSEG, PCPAINT, TIFF, or SCREEN.
ELIXIR creates an output image in Elixir (.LP3) image
format. The output .LP3 file is written to the
drive:\ELIXIR\PICS\PRINTER directory. A screen version (.LW8) of the file is also created in the
drive:\ELIXIR\PICS\SCREEN directory.
PCPAINT creates a PCX format image file in the
drive:\ELIXIR\PICS\PCXOUT directory (black-andwhite only).
TIFF creates TIFF (.TIF) format files in the
drive:\ELIXIR\PICS\TIFFOUT directory (black-andwhite only).
SCREEN creates Elixir screen format (.LW8) versions
of a image file that work with the image in ElixirForm.
The
output
file
is
created
in
the
drive:\ELIXIR\PICS\SCREEN directory.
-Dnnn
specifies the output resolution in dots per inch: 300 or
240.
-Faaa
is the output record format for AFPDS output: VBM,
AS400, IRMA, OS2, or MODCA.
-Wa
Y removes, and N does not remove white space from
an AFP page segment.
-Rnnn
the number of degrees to rotate pages.
8-6
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-Xnnn
the horizontal offset in pels.
-Ynnn
the vertical offset in pels.
-Saaa
allows you to specify your monitor type: VGA, SUPERVGA, SIGMA, or WYSE.
Directory
information
Example

The current directory changes to drive:\ELIXIR to run
IC unless you have included drive:\ELIXIR in a DOS
PATH= statement.
To input an Elixir-format file named FBLOGO and create a PSEG-format file, type:

1.

CD \ELIXIR <Enter>

The current directory changes to drive:\ELIXIR where
the IC utility resides.

2.

IC FBLOGO ELIXIR PSEG -FVBM
-D240 -WN <Enter>

The Elixir-format file converts to PSEG format.

SF
The SF utility converts Elixir-format font files to screen
font files. Use this utility to create screen fonts from
Elixir-format files that are larger than 64 KB, or if a
low-memory warning message displays when creating
screen fonts with ElixirForm.
Usage

SF filename [monitor] <Enter>
filename
is the name of the source Elixir font.
monitor
allows you to specify your monitor as one of the following: SIGMA, WYSE, VGA, XEROX or SUPERVGA. These options resize the font bitmap for the
correct screen.
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Directory
information
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Run SF from the directory in which the input files reside. If you have not specified drive:\ELIXIR in your
DOS PATH= statement, precede the SF command
with drive:\ELIXIR\.
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A.

Keyboard shortcuts

This appendix lists all keyboard shortcuts for ElixirForm operations and for child window menus.

Desktop
Close dialog box/menu

<Esc>

Organization of the following Desktop keyboard shortcuts is by pull-down menu.
File menu

<Alt> + <F>

Close (top window)

<F3>

Convert

<Ctrl> + <V>

Copy to

<Ctrl> + <C>

Copy quit

<Esc>

Delete

<Del>

Dispatch

<Ctrl> + <I>

Exit

<Alt> + <F4>

Formats

<Ctrl> + <F>

Help

<F1>

Open

<Enter>

Print

<Ctrl> + <P>

Properties

<F2>
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System menu

<Alt> + <S>

System Configuration

<Alt> + <F6>

Diagnostics

<Alt> + <F5>

Make Directory

<Ctrl> + <M>

Special menu

<Alt> + <P>

Close All

<F4>

Efont Factory

<Alt> + <E>

Scheduler Action

<Alt> + <F3>

Scheduler Setup

<Alt> + <F2>

DOS menu

<Alt> + <D>

DOS command

<Ctrl> + <D>

Window menu

<Alt> + <W>

Help menu

<Alt> + <H>

Contents

<F1>

Back up one directory level

<Ctrl> + <B>

Display start of file list

<Home>

Display end of file list

<End>

Windows

A-2
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Display next page

<Page Down>

Display previous page

<Page Up>

Filter menu

<Alt> + <I>

Jump to files beginning with
letter...

press <letter>

Reselect

<Ctrl> + <R>

Select adjascent file

Left/Right/Up/Down
arrow keys

Select/Unselect All

<Ctrl> + <A>

Write Selections

<Ctrl> + <W>

By option name
Back up one directory level

<Ctrl> + <B>

Close top window

<F3>

Close All

<F4>

Close dialog box/menu

<Esc>

Convert

<Ctrl> + <V>

Copy to

<Ctrl> + <C>

Delete

<Del>

Diagnostics

<Alt> + <F5>

Dispatch

<Ctrl> + <I>

Display start of file list

<Home>

Display end of file list

<End>

Display next page

<Page Down>
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A-4

Display previous page

<Page Up>

DOS

<Ctrl> + <D>

Exit Elixir

<Alt> + <F4>

Filter menu

<Alt> + <I>

Formats

<Ctrl> + <F>

Help

<F1>

Jump to files beginning with
letter...

press <letter>

Make PubFile

<Ctrl> + <U>

Open

<Enter>

Print

<Ctrl> + <P>

Properties

<F2>

Reselect

<Ctrl> + <R>

Select adjacent file

Left/Right/Up/Down
arrow keys

Select All

<Alt> + <A>

Scheduler Action

<Alt> + <F3>

Scheduler Setup

<Alt> + <F2>

System Config

<Ctrl> + <F6>

Unselect All

<Ctrl> + <A>

Write Selections

<Ctrl> + <W>
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Glossary

This glossary provides a list of the basic terms used in
this guide.
Application: Any program you run on your PC. Elixir
applications are represented by icons on the ElixirForm/Elixir Desktop. If an Elixir application is not installed on your PC, its icon does not display.
Arrow: An arrow-shaped screen pointer used for selecting objects.
Boxed text: Text on a form that is bound by a column
with a set height and width.
Button (on the screen): An area on the screen that
causes a response when you click on it. For example,
an [OK] button that accepts your entries when you
click on it in a dialog box.
Click, on an item: To momentarily press and release
the left mouse button with the screen pointer on an
item.
Close: To exit from a window, dialog box, application,
or the Desktop.
Close box: A small white box at the left of a window
header and at the left of the menu bar. Clicking a
close box on a window header closes the window.
Clicking a close box on the menu bar exits the
Desktop.
Command button: A button in a dialog box that confirms or cancels an action when you click on it. The
[Cancel] button cancels the command. The [OK] button confirms and executes the command and saves
the information you specified in a dialog box.
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Converter icon: The icon that converts font, form, image and document files to and from different formats.
Cursor: A screen pointer used when entering text in
the work area or in a dialog box.
Desktop: The Elixir Desktop working environment,
consisting of the menu bar, the screen area and icons
on the screen.
Dialog box: A rectangular box that displays and requests information. You enter information in fields in
the dialog box, and normally confirm your entries by
clicking on an [OK] button or by pressing <Enter>.
Directory: A list of hard disk or diskette contents.
Desktop directories are represented by folder icons.
Folder contents can be viewed pictorially, alphabetically, by icon, by size, or by date.
Dispatcher icon: The icon in the Elixir Desktop that
stores and invokes a number of DOS commands.
DOS: Disk Operating System, the collection of programs that gives control of a PC's resources to the
user.
Double-click: To press the left mouse button twice in
rapid succession, normally to open an icon.
Drag: To click on an item and move the item with the
mouse while holding down the left mouse button.
Drag and drop: A method used to copy an object as
follows: click on an item on the screen, hold down the
left mouse button, move the mouse to move the
screen pointer to an icon, then release the mouse
button.
Drop: To release the mouse button after dragging an
item to an icon.
Elixir folders: The folders represented by the four
top left icons on the Desktop: the Forms, Fonts, Images and Documents folders. Each of these folders
contains a subordinate Elixir, Input and Output folder.
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Extension: The period and three characters following
a file name. An extension identifies the type of information in a file. For example, .ELX indicates an Elixir
format form file.
Fast Keys: See Keyboard shortcuts.
File filter: The use of DOS wildcard characters to display only those files with selected name characteristics in a window or dialog box. For example, to display
only files that begin with ABC in a directory of many
files you could enter ABC*.*. See also, Wildcard
character.
File name: The name of a file. The ElixirForm/Elixir
Desktop uses DOS file naming conventions. DOS file
names consist of a base (stem) name containing up to
eight characters and an extension of up to three
characters.
Folder icon: The Desktop icon representing a DOS
directory. Folders allow you to quickly organize information on the Desktop.
Format: To prepare a diskette so it can hold information. Formatting a diskette erases the information on
the diskette.
Form elements: The individual lines, shapes, images,
and text that compose a form. You can create,
change, move, copy, delete, import, or load a form
element.
Form template: A form loaded as an overlay or visual
guide only for the purpose of designing new form elements around it. A form template does not become
part of the form when the form is saved, only the new
elements added are saved with the form.
Free text: Text on a form that is not bound by a column with a set height and width. The width of the form
is the only restriction.
Grayed options: Grayed options are menu options
you cannot choose because they do not apply to your
current selection. Also called dimmed options.
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Head to head: In duplex printing, when the page top
is printed in the same position on both sides of the
page.
Head to toe: In duplex printing, when the top of one
side of the page is printed in the same position as the
bottom of the other side of the page.
Highlighted: A highlighted option appears darkened
on the screen, and indicates that it is selected.
Icon: A small, roughly rectangular-shaped symbol on
the Desktop that represents an application, a file, a
folder, or a peripheral device.
Importing files: The process of copying non-Elixir
format files from different storage media (such as a
hard disk, a diskette, or tape) to the appropriate Desktop input folder or to the Work area.
Information box: A white square at the right of the
menu bar identified with an "i". Clicking on the information box displays information about the open Elixir
Desktop application.
Inverse Landscape: The orientation of fonts, logos,
or images on a page. See the definition for portrait for
a figure describing the orientation of fonts on pages.
Inverse Portrait: The orientation of fonts, logos, or
images on a page. See the definition for portrait for a
figure describing the orientation of fonts on pages.
Kerning: Adjusting the spacing between characters to
make certain letters appear better fitted together and
more attractive on the page.
Keyboard shortcut: Also called Fast keys. A special
one- or two-key combination that allows you to execute an option without using the mouse. Keyboard
shortcuts are shown on each menu beside the name
of the option and are listed in the “Keyboard shortcuts”
appendix.
Landscape: The orientation of a page or the fonts, logos, or images on a page. A landscape page is narrower on the sides than on the top. See the definition
of portrait for a figure describing the orientation of
fonts on pages.
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Menu: A list of options from which you make a selection to perform an action. A menu displays when you
select a menu title from the menu bar or from a window header, or when you click on an option.
Menu bar: The horizontal bar displayed at the top of
the Desktop from which you access pull-down menus.
Menu titles: Text that identifies a menu, displayed in
a window header or on the menu bar.
Message area: A bar just below the menu bar that
displays error messages or information about the activity you are performing.
Mouse button: A button on the top of the mouse.
ElixirForm uses the left and right buttons of a mouse.
Multi-select: Selecting more than one file or icon by
shift-clicking on them.
Open a folder, Elixir file, application, or peripheral
device: 1.) Opening a folder icon displays a window
showing the contents of the folder. 2.) Opening an
Elixir file icon starts the application that created the file
and loads the file . 3.) Opening an application icon
starts the application. 4.) Opening a peripheral device
displays a dialog box allowing you to set the device
parameters.
Option: A word or phrase in a menu that you can
select.
Peripheral (device): A printer, scanner, or tape drive
connected to your PC.
Point: To move the mouse so the screen pointer (in
most cases an arrow) rests on the desired item.
Portrait: The orientation of a page, or the fonts, logos, or images on a page. A portrait page is narrower
on top than on the side (like pages in this book). See
the following figure for the orientation of fonts on
pages.
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Orientation of fonts on Portrait (left) and
Landscape pages
Printer icon: An icon representing a proof printer connected to your PC.
Pull-down menu: See menu.
Raster graphics: Pictures composed of bit maps,
where each element of the picture is a dot defined as
black or white.
Replaceable parameter: A parameter (usually %1)
used in commands to represent a selected file name.
The selected file name replaces the parameter during
certain operations.
Run: To execute or start an application.
Scanner icon: The icon representing a scanner connected to your PC.
Screen pointer: A pointer shaped like an arrow that
displays on the screen, and which you can move by
rolling the mouse on a flat surface.
Screen version: The version of a color or font composed such that its appearance on a screen display is
as close as possible to its appearance when printed.
Scroll: To move a directory list in a window so you
can view different parts of the list.
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Scroll bar: A bar displayed on the right side of some
windows used for scrolling. The scroll bar contains a
scroll arrow, [+] and [-] buttons, and a slider bar that
moves within the scroll box.
Select: To click on an object, menu option, or form
element. A selected item appears highlighted.
Shift-click: To click on an object while holding down
the <Shift> key. Usually used to select multiple
elements.
Slider bar: A bar in the scroll box at the side of some
windows that scrolls items in the window when you
drag it up and down.
Snap to: A function that causes form elements to
automatically align with the nearest grid point when a
grid is displayed in the Work area.
Tape icon: The icon representing a tape drive connected to your PC.
Trashbin icon: The Trashbin icon is in the lower right
corner of the Desktop and represents a receptacle for
items you want to delete. You delete a file by dragging
it to the Trashbin icon.
UDK: (User Defined Key) a substitute escape character defined by a user for specific print jobs
Unselect: To cause one or more selected (highlighted) icons or elements to not be selected any
more. The quickest way to do this is to click on another area of the Desktop or Work area.
UserTools icon: The icon that links applications to
files.
Utilities: Special-purpose applications with which you
can perform functions from the DOS prompt.
Wildcard character: A character in a file name, usually an asterisk (*), that specifies a matching set. For
example, *.EXE represents all files that end with the
.EXE extension.
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Window: A rectangular area on your screen in which
you view information, such the contents of a folder. All
windows contain a window header. Some windows
have scroll bars along the right side.
Window header: The top of a window that displays
the DOS directory corresponding to the window contents. Some window headers also show a close box
and a number of menu titles with pull-down menus.
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A
adding multiple fonts,
6-16
AFPVIEW, 8-2
ASCII text, 6-12
auto save, 3-22

B
backup file, 3-23
making, 3-23
boilerplate, 1-1
boxes, 4-1
corner radius, 5-6
corner style, 5-5
drawing, 5-4
positioning, 5-5
shading, 5-6
shape, 5-5
splits, 5-6
with diagonal lines,
5-5
Bubble Help, 1-6

C
circles
border styles, 5-8
border width, 5-8
diagonals, 5-8
drawing, 5-7
radius, 5-7
start/finish angle,
5-8
column height, 6-4
column width, 6-4
comments, 3-13
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Context sensitive Help,
1-6
conventions, 1-4
copying elements, 4-6
crosshair, 3-6
customer support, 1-3

D
default
forms directory, 3-23
settings, 3-8
deleting a form, 2-15
deleting elements, 4-8,
6-21
Desktop
keyboard shortcuts,
A-1
Dialog box Help, 1-6
DocuMerge, 6-15
DocuTag, 6-15

E
elements
adding, 2-8
editing, 2-11
excluding, 2-13
grouping, 2-12
shifting, 2-11
Elixir applications
Help, 1-5
exit, 1-8, 2-20

F
fast keys, 2-20, A-1, A-4
filing options, 3-22
INDEX-1

INDEX

font
adding multiple
fonts, 6-16
changing a, 6-10,
6-16
list, 6-6
load font list, 6-6
merging a font list,
6-7
replace, 6-10
selection, 6-6
sort font list, 3-15
font list, 6-6
FONTCHG utility, 8-3
fonts
font directory, 3-23
form
deleting, 2-15
moving, 2-15
renaming, 2-15
saving, 2-9, 2-10
FORMPRN UTILITY,
8-4
forms
form directory, 3-23
modifying, 2-11
free text, 6-4

G
GEM forms, 2-6, 3-19
grid, 3-1
color, 3-3
show, 3-3
step, 3-3
units, 3-2
use grid/inch, 3-3,
3-6
grouping form elements,
2-12
groups
defining, 2-12
merging, 2-7
saving, 2-14

H
INDEX-2

hardware requirements,
1-7
Help, on-line, 1-5
Help hypergraphics, 1-7
Help menu, 1-6
Help pop-ups and
jumps, 1-6

I
IC UTILITIY, 8-5
images, 7-1
.LP3, 7-2
.LW8, 7-2
copying, 7-5
deleting, 7-5
editing, 7-3
loading, 7-1
moving, 7-4
toolbox, 7-1
importing text
scrolling, 6-14
inserting data tags, 6-15
inter-character spacing,
6-2
inter-word spacing, 6-2

J
join text, 3-15
using justify, 3-15
using relatives, 3-15,
3-16, 3-20
using spaces, 3-15,
3-16, 3-17, 3-18,
3-21, 3-22
joining text, 6-17

K
keybaord shortcuts, A-4
keyboard mapping, 3-16
keyboard shortcuts, A-1

L
landscape, 2-18
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lines, 4-1
changing, 4-4, 4-6
copying, 4-6
deleting, 4-8
direction, 4-3
displaying, 4-1
drawing, 4-2
editing, 4-4
extend by half width,
3-21
moving, 4-7
show as WYSIWYG, 3-21
style, 4-3
toolbox, 4-2
width, 4-3
loading
.LP3 images, 7-2
.LW8 images, 7-2
GEM forms, 2-6
images, 7-1
new forms, 2-5
saved forms, 2-5
lock text, 3-14
long crosshair, 3-6

M
menu bars, 2-3
merging groups, 2-7
modifying a form, 2-11
move form, 2-15
moving elements, 4-7

N
non-standard characters, 6-12

O
OGL, 1-2

P
page author, 3-11, 3-12
page databasing, 3-11
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page description, 3-12
page properties, 3-8,
3-12
page shift, 2-18
pan, 3-6
paper size, 2-20
paths
border style, 5-3
border width, 5-3
direction, 5-3
draw/done mode,
5-3
drawing, 5-1
locked, 5-2
shading, 5-3
styles, 5-3
portrait, 2-18
print
disk file, 2-19
printer, 2-17
PCL 4, 2-17
proof printing, 2-17

Q
Quick Help, 1-6

R
rename form, 2-15
ruler, 3-3, 3-4
digital, 3-6
display units, 3-5,
3-10
graphic, 3-5, 3-6

S
save form group, 2-14
saving a form, 2-9, 2-10
SF UTILITY, 8-7
shapes
changing attributes,
5-10
changing size, 5-9
copying, 5-11
deleting, 5-13
INDEX-3

INDEX

drawing, 5-1
editing, 5-9
moving, 5-11
shifting elements, 2-11
short page description,
3-12
shortcuts, keyboard, A-1
show grid, 3-3
snap mouse speed, 3-3
snap to grid, 3-3, 3-4
soft keyboard, 6-12
software requirements,
1-7
Spell checking, 6-21
spell checking options,
6-22
stand-alone utilities, 8-1
starting ElixirForm, 1-8
static data, 1-1
sticky lines, 4-5, 4-8
support, customer, 1-3

T
tab length, 3-14
template, 2-8
text
attributes, 6-2
boxed, 6-5, 6-15
color, 6-3
copying, 6-19
creating, 6-1
cut and paste, 6-20
deleting, 6-21
editing, 6-15
free, 6-4
importing, 6-12
joining, 6-17
justification, 6-3
moving, 6-18
options, 3-13
spacing, 6-4
spell checking, 6-22
wrapped, 6-3
text baseline rotation,
6-2

INDEX-4

text formatting compatibility, 3-15, 3-19, 3-20,
3-21
text import mapping,
3-17, 3-18
texts directory, 3-23
toolbar, 2-1, 2-3
toolbox, 2-1, 2-2
image, 7-1
line, 4-2
text, 6-1
track text, 3-14
training, 1-3

U
undo/redo, 2-14
usage switches, 3-20
user preferences, 2-10,
3-1
utilities, stand-alone, 8-1
utility
FONTCHG, 8-3

V
variable/fixed data, 1-1

W
Windows
keyboard shortcuts,
A-2
work area, 2-1
wrapped text, 6-3

Z
zoom, 2-20
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